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About this Manual
Welcome to the Acer n20 Handheld Manual. This Manual is designed to help you get 
up and running quickly with your new Acer n20—a Windows® Powered Pocket PC 
2002 handheld. It describes all you need to know about how to use your handheld as 
well as the application programs that come with it. 

This Manual will discuss the following topics: 

• Acer n20 system tour 
• Setup and maintenance procedures 
• Viewing and entering data 
• Using the application programs bundled with you handheld
• Taking advantage of your handheld’s expansion features
• Synchronising data between your handheld and your computer
• Connecting your handheld to a computer, a network, or the Internet
• Personalising your handheld with your own preference settings

This Manual introduces you to the many ways your Acer n20 can help you organise 
and manage both business and personal information to make your everyday activities 
a more productive and satisfying experience. 
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First things first
We would like to thank you for making Acer n20 your choice for your handheld 
needs. Your new sleek Acer n20 is a multi-functional tool packed with user-friendly 
features and high-performance applications designed to make organising work-
related information and synchronising it with your personal activities a time-efficient 
task. We hope you enjoy using your Acer n20 as much as we enjoyed creating it for 
you.

Use your Acer n20 to effectively manage information related to both business and 
personal tasks.

• Use the Microsoft® Pocket PC 2002 software to perform organising and 
computing tasks 

• Synchronise the information on your computer with the information on your 
handheld using Microsoft® ActiveSync®

• Get connected to the Internet with the Microsoft® Pocket Internet Explorer
• Create an on-the-go backup file 
• Expand your handheld’s capabilities using either the built-in Memory Stick 

slot or the optional expansion sleeve 
• Beam information to another IR-enabled device 
• Communicate using the built-in wireless communication feature (applicable 

to the Acer n20w model only)
• Customise your handheld based on your personal requirements and 

preferences

Your guides
To help you use your Acer n20, we have designed a set of guides: 

For information on: Refer to:

Programs on your handheld This Manual. 
Bundled in the Acer n20 Handheld Companion CD, it 
provides online reference for using your Acer n20. 

The Acer n20 Handheld Help.
To view Help, tap  and then Help. 

Programs on your handheld

Additional programs that can be 
installed on your handheld

The Acer n20 Handheld Companion CD.

Connecting to and synchronising 
with your computer

The Just for Starters... poster. 

ActiveSync Help on your computer. 
To view Help, click Help and then Microsoft 
ActiveSync Help.
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Package contents
Your Acer n20 comes packed in a cardboard box. Carefully unpack the box and 
remove the contents. If any of the following items are missing or damaged, contact 
your dealer immediately:

Optional accessories
To create more variety and expand the capabilities of your Acer n20, you can purchase 
the following optional accessories. 

Taking care of your Acer n20
This section provides information on the following:

• Proper care and usage of your handheld
• Resetting your handheld

Proper care and usage of your Acer n20
Your Acer n20’s rugged and tough construction is designed to provide you with years 
of reliable and trouble-free service. Observing the following general maintenance 
procedures will help ensure this:

Last-minute updates and detailed 
technical information

The Read Me files. 
Located in the Microsoft ActiveSync folder on your 
computer and on the Acer n20 Handheld Companion CD.

Up-to-date information 
regarding your handheld 

http://www.acer.com/

For information on: Refer to:

• Acer n20 handheld • Just for Starters... poster

• Stylus • Acer n20 Handheld Quick Guide

• USB cradle • Acer n20 Handheld Companion CD

• Battery pack • Acer n20 Handheld Accessories Catalogue

• AC adapter • Warranty Agreement

• Expansion sleeve • Earphones with microphone

• Extra battery pack • 4-in-1 handheld pen

• Plug adapter • Colour stylus pack

• USB sync cable • Leather cover

http://www.acer.com
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1 Take care not to scratch the screen of your handheld. Keep the screen clean. When 
working with your handheld, use the supplied stylus or plastic-tipped pens intended 
for use with touch-sensitive screens. Never use an actual pen or pencil or other sharp 
object on the screen surface. 

2 Your handheld is not waterproof and should not be exposed to rain or moisture. 
Under extreme conditions, water may enter the circuitry through the front panel 
buttons. In general, treat your handheld as you would a pocket calculator or other 
small electronic device.

3 Take care not to drop your handheld or subject it to any strong impact. Do not place 
your handheld in your back pocket; if you sit on it, you may damage it. 

4 Protect your handheld from temperature extremes. For example, do not leave your 
handheld on the dashboard of a car on a hot day or on a day when temperatures are 
below the freezing point. Also, keep it away from heaters and other sources of heat. 

5 Do not use or store your handheld in any location that is extremely dusty, damp or 
wet. 

6 Use a soft, damp cloth to clean your handheld. If the surface of the screen becomes 
soiled, clean it with a soft cloth moistened with diluted window-cleaning solution.

Resetting your Acer n20
You may have to perform a reset if your handheld no longer responds to the buttons 
on the screen.

Performing a soft reset
A soft reset allows your handheld to get a fresh start, similar to rebooting a computer. 
All records and entries are retained after a soft reset.

To perform a soft reset: 
• Using the tip of your stylus, lightly press the reset button inside the hole on 

the rear panel of your handheld.
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Performing a hard reset
A hard reset will erase all records and entries stored in your handheld. Never perform 
a hard reset unless a soft reset does not correct your problem. When you perform your 
next ActiveSync operation, you can restore any data that you previously synchronised 
to your computer. To perform a hard reset, do the following:

1 Detach the battery pack from your handheld. 

Refer to "To uninstall the battery pack" on page 9 for instructions. 

2 Slide up the hard reset switch located on the right side of the battery bay (a) then 
slide it down again (b).

3 After resetting your handheld, reinstall the battery pack in its bay. 

Refer to "To install the battery pack" on page 8 for instructions. 

NOTE: When you perform a hard reset, the current date and time are retained. Formats, 
preferences, and other settings are restored to their factory default settings.
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Locking your Acer n20
Your handheld is not just a financial investment but a wealthy source of personal 
information, some of which may be confidential so it is only logical to protect it from 
any unauthorized access. The Security setting gives you the option of assigning a lock 
password that will be required to access your handheld after a set period of inactivity. 

To assign a lock password

1 Tap , Settings. 

2 On the Personal tab, tap Password. 

3 Select a password option.

• Simple 4 digit password
• Strong alphanumeric password

4 Define the period of inactivity before the lock password will be required for access. 

5 Enter a password then retype it to confirm.

For more information, refer to "Password" on page 124.
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1 Getting started 
This chapter will discuss the following topics: 

• Feature highlights of your Acer n20 
• Acer n20 system tour 
• Step-by-step procedures on how to prepare your handheld for use
• Basic concepts in using your Acer n20

Features summary

Performance
• Intel® PXA250 Applications Processor with Intel® XScaleTM Technology 
• System memory: 

– 64 MB SDRAM for application storage
– 32 MB Flash ROM for operating system

• Microsoft® Pocket PC 2002 Premium with Microsoft® Outlook 2000 

Display
• 3.8" Reflective TFT LCD (Thin Film Transistor Liquid Crystal Display) 
• 240 x 320 resolution
• 16-bit or 64K colour support 

• Microsoft® ClearType technology for clearer, crisper font display
• MediaQ graphics controller for enhanced graphics performance 

Audio
• Embedded AC '97 CODEC with CD-quality stereo output 
• Built-in industry-standard 3.5-mm earphone jack 
• Built-in microphone

Connectivity
• 19-pin Acer Versatile Connector 
• 100-pin expansion connector
• SIR (Standard Infrared) capability 
• Wireless communication function using the built-in IEEE 802.11b WLAN 

(Wireless LAN) adapter (applicable to the Acer n20w model only)



1 Getting started
Features summary

2   

Expansion
• Integrated Memory Stick slot
• Acer Versatile Connector
• Expansion sleeve (optional, sold separately) 

– CompactFlash Type II slot
– PC Card Type II slot 
– Standard USB host connector

Battery pack
• Removable and rechargeable Lithium polymer battery

– Acer n20 - 1000 mAH capacity battery pack
– Acer n20w - 2000 mAH capacity battery pack

• Operation time for normal usage
– Acer n20 - 8 hours
– Acer n20w - 15 hours

NOTE: Length of battery operation will depend on power consumption which in turn is 
based on system resources use. For example, constantly using the backlight or using power-
demanding applications will shorten the length of battery operation.

• Charging time from empty to full capacity
– Acer n20 - 4 hours
– Acer n20w - 8 hours

• Built-in backup battery 

Design and ergonomics
• Stylish, light and thin design 

• User-friendly navigation features 
– Scroll wheel for one-hand operation
– Directional pad for multi-directional scrolling in various menus and 

applications
– Quick buttons to easily launch commonly-used applications

– Start button for one-tap access to all available applications 

– Hold switch lets you lock all buttons from being accidentally pressed 
when handheld is placed in pocket or in a bag.

Specifications Acer n20 Acer n20w

Height 12.9 cm 12.9 cm

Width 7.9 cm 7.9 cm

Depth 1.29 cm 1.96 cm

Weight 180g 235g
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Acer n20 tour 

Front view

No. Component Description

1 Power button/
LED indicator

Press to turn on your handheld (LED lights up green) if it is 
off and returns to the last screen that was displayed, and 
off if it is on. 

LED status description. 

• Flashing green - Charging handheld
• Steady green - Charging complete
• Flashing red - Alarm indicator, email is received

2 Stylus holder Secures the stylus to your handheld. To use the stylus, 
remove it from its holder and hold it the same way you 
hold a pen or pencil. 

3 LCD touchscreen Displays the applications and data stored in your handheld. 
It is touch-sensitive and responds to the stylus or your 
finger.

4 Quick button for 
Today

Displays the Today screen. 
For more information on this screen, refer to page 15.

5 Quick button for 
Calendar

Activates the Calendar program. 
For more information on this program, refer to page 33.
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NOTE:
Refer to "Personal" on page 122 for instructions on how to reassign the hardware buttons to 
other applications installed on your handheld. 

If your handheld is turned off, pressing any Quick button turns on the handheld and opens 
the program assigned to that button. 

Using the backlight
If lighting conditions make it difficult for you to see the information on your 
handheld, use the backlight to illuminate your screen. 

You can change the backlight settings. Refer to "System" on page 126. 

To activate the backlight:
• Press the power button and hold it down for about two seconds. Release the 

button when the backlight turns on. 

To turn off the backlight:
• Press the power button and hold it down for two seconds. Release the button 

when the backlight turns off.

6 Directional pad Enables multi-directional scrolling in various menus and 
applications. Press the center of the pad on to simulate the 
function of the Enter key. 

7 Quick button for 
Contacts

Activates the Contacts program. 
For more information on this program, refer to page 36.

8 Quick button for 
Inbox

Activates the Inbox program. 
For more information on this program, refer to page 43.

9 Microphone Inputs audio into your handheld. 

10 Internal speaker Outputs sounds from your handheld.

No. Component Description
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Left view  

No. Component Description

1 Record button Activates the Microsoft® Pocket PC’s Record program. 
For more information on how to use this program, refer to 
page 26.

2 Scroll wheel Scroll one page up or down to display the text and other 
information that extends beyond the area of the LCD 
touchscreen. 

3 Start hardware 
button

Hardware button to display the Start menu.

4 Hold switch Slide to lock all buttons from being accidentally pressed when 
handheld is placed in pocket or in a bag.
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Top view  

No. Component Description

1 Memory Stick 
slot 

Accepts a Memory Stick, allowing you to add more memory, 
install add-on applications or use audio or text files stored in it 
for use with internal applications. You can also use it to back up 
data from your handheld. 

2 Earphone jack Connects to audio line-out devices (earphones/headphones). 

3 Infrared (IR) 
port

Uses infrared technology to transmit and receive data from 
other IR-enabled devices. 
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Bottom view  

Preparing to use your Acer n20
Perform first the following easy setup tasks to begin using your handheld: 

• Install the Microsoft® ActiveSync® software in your computer
• Install the battery pack
• Connect the cradle
• Charge your handheld
• Set up your handheld
• Perform the first ActiveSync operation

Installing the Microsoft® ActiveSync® software 
The main function of the Microsoft® ActiveSync® software is to synchronise the 
information on your computer with the information on your handheld. 
Synchronisation compares the data on your handheld with your computer and 
updates the information on both locations. This will then served as a backup file in 
case something happens to your handheld.

No. Component Description

1 Acer Versatile 
Connector 

Connects your handheld to the cradle, which in turn connects to 
the back of your computer and through the AC adapter to the 
wall current. This allows you to recharge your handheld and 
perform an ActiveSync operation. You can also use it to connect 
peripheral hardware devices, such as an external keyboard, to 
your handheld. 

2 Battery 
release switch

Unlatch to detach the removable battery pack from its bay. 

3 Battery bay Houses the handheld’s battery pack. 
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The following instructions tell you how to install the ActiveSync® software. 

Important installation notes 
• Before installing ActiveSync, make sure that your handheld cradle is not yet 

connected to your computer. Connect the cradle only after you have finished 
installing ActiveSync.

• If you don’t have Microsoft® Outlook® 98 installed, please install Microsoft® 
Outlook® 2000 now. 

• It is recommended that users choosing to install Outlook 2000 from this CD 
do so before installing ActiveSync.

• Do not copy the ActiveSync files to your computer’s hard disk. You must use 
the Acer n20 Handheld Companion CD to place the files in their proper 
locations and to decompress the files.

To install the Microsoft® ActiveSync® software
1 Exit any open programs, including those that run at startup, and disable any virus-

scanning software.

2 Insert the Acer n20 Handheld Companion CD into the computer’s CD-ROM drive. 

The CD’s welcome page appears. 

3 Click the animated forward icon to go to the next screen. 

4 Click the Start Here tab on the right side of the screen. 

5 Read the instructions and installation notes indicated on the Start Here screen. 

6 Click the buttons on the left pane to install each of the individual applications.

• Outlook 2000 (recommended)

• ActiveSync® 3.5
After installation, the ActiveSync icon  will appear on your computer’s system tray 
(on the lower right-hand corner of the screen). 

Refer to the ActiveSync software online Help for information on how to use the 
software. If at any time, you would like to restart this setup program, simply re-insert 
the CD into the CD-ROM drive.

Installing the battery pack
Your Acer n20 uses a removable and rechargeable Lithium polymer battery pack. 
Refer to the succeeding section for instructions on how to install the battery pack to 
your handheld. 

To install the battery pack
1 Turn the handheld over to access its rear panel. 

2 Check that the battery release switch is in the Unlock position.

3 Slide down the hard reset switch located on the right side of the battery bay.
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IMPORTANT: You will only need to slide down the hard reset switch for the initial 
installation of the battery pack. There is no need to use this switch for subsequent battery 
pack reinstallation unless you intend to perform a hard reset. For more information on 
performing a hard reset, refer to page viii. 

4 Insert the battery pack into the battery bay (a), then slide the battery release switch to 
the Lock position (b).

To uninstall the battery pack
1 Turn the handheld over to access its rear panel. 

2 Slide the battery release switch to the Unlock position (a), then pull out the battery 
pack from its bay (b).
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IMPORTANT: Do not remove the battery pack for more than 30 minutes, unless you intend 
to use the expansion sleeve; otherwise you risk losing all data on the internal memory of your 
handheld. 

Connecting the cradle 
The cradle that comes with your handheld enables you to charge your handheld as 
well as synchronise the information on your handheld with those in your computer 
using ActiveSync technology. 

To connect the cradle
1 Connect the AC adapter cord to the power socket at the back of the cradle. 

2 Plug the AC adapter into any AC current outlet.
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Charging your Acer n20
For initial use, you need to charge your handheld for three hours. After that, you can 
charge it for a few minutes each day to recharge the battery to full capacity. Normally, 
you can use your handheld for eight straight hours of operation before you need to 
recharge the battery. 

To charge your Acer n20
You use the cradle to charge your handheld. 

1 Connect the AC adapter connector to the power socket at the back of the cradle, then 
plug the other end of the AC adapter into any AC current outlet. 

2 Insert your handheld into the cradle. The bottom edge of your handheld should align 
smoothly with the cradle when it is inserted properly. 
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LED status during charging: 
• Charging: Flashing green
• Charging complete: Steady green

If the battery level becomes low in the course of normal use, a status icon appears on 
the handheld screen indicating low or very low battery status (refer to "Status icons" 
on page 15). Perform an ActiveSync operation to back up your data, then recharge the 
battery. 

If your handheld shuts down (i.e., battery is completely drained out) you have about 
30 minutes to recharge the battery before you lose all data on your handheld’s 
internal memory. 

The battery pack is removable. Refer to the succeeding section for instructions on how 
to remove it from the battery bay. 

NOTE: You have the option to purchase a spare battery pack for your handheld. 

Setting up your Acer n20
After you have initially charged your handheld for three hours, you can now set it up 
for use. Refer to the instructions below. 

To set up your Acer n20
1 Turn on your handheld by pressing the power button on the front panel.

2 Follow the onscreen instructions to set up your handheld.
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Performing the first synchronisation process
After completing the setup procedures you can now perform the first ActiveSync 
operation with the help of the 'New Partnership' setup wizard. 

This wizard will help you:

• Set up a partnership so you can synchronise information between your 
handheld and your computer

• Customise your synchronisation settings

To perform the first synchronisation process
1 Connect the cradle. 

For instructions, refer to page 10. 

2 Insert your handheld in the cradle. 

The bottom edge of your handheld should align smoothly with the cradle when it is 
inserted properly. 

3 Plug the cradle’s USB connector into a USB port on your computer. 

The 'New Partnership' setup wizard will automatically start on your computer screen.
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NOTE: If the wizard does not automatically appear, launch ActiveSync on your computer by 
clicking on its icon from Start > Programs. 

4 Follow the onscreen instructions. 

The first synchronisation process will automatically begin when you finish using the 
wizard. 

After your first synchronisation, take a look at Calendar, Contacts, and Tasks on your 
handheld. You'll notice that information you've stored in Microsoft Outlook on your 
computer has been copied to your handheld, and you didn't have to type a word. 
Disconnect your handheld from your computer and you're ready to go!

Once you have set up ActiveSync and completed the first synchronisation process, you 
can initiate synchronisation from your handheld. To do so, on your handheld, tap , 
then tap ActiveSync. 

NOTE: If you have a wireless LAN card, you can synchronise remotely from your handheld. 
For Acer n20w models, you can use the built-in IEEE 802.11b WLAN adapter. 

Command interface

Hardware buttons and the stylus
Your handheld has hardware buttons that control actions and scroll functions, and a 
stylus for selecting items and entering information.

On your handheld, the stylus replaces the mouse.
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• Tap. Touch the screen once with the stylus to open items and select options.
• Drag. Hold the stylus on the screen and drag across the screen to select text 

and images. Drag in a list to select multiple items.
• Tap and hold. Tap and hold the stylus on an item to see a list of actions 

available for that item. On the pop-up menu that appears, tap the action you 
want to perform.

Today screen
When you turn on your handheld for the first time each day (or after 4 hours of 
inactivity), you'll see the Today screen. You can also display it by tapping  and then 
Today. On the Today screen, you can see, at a glance, a list of important reminders for 
the day.

Status icons
Following are some of the status icons you may see.

Tap to switch
to a program. 

Tap to adjust volume
or mute all sounds. 

Tap to change date and time.

Tap to open an item.

Your day at a glance.

Tap to create a
new item.

Tap to view 
connection status.

Status icon Description

Turns all sounds on and off 

Backup battery is low 

Main battery is charging 
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1 If more notification icons need to be displayed than there is room to display them, the Notification
icon appears. Tap the icon to view all notification icons.

Navigation bar and command bar
The navigation bar is located at the top of the screen. It displays the active program 
and current time, and allows you to switch to other programs and close screens.

Main battery is low 

Main battery is very low 

Main battery is full

Connection is active 

Synchronisation is beginning or ending

Synchronisation is occurring

Notification1 that one or more instant messages were received 

Notification that one or more email messages were received 

Status icon Description
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Use the command bar at the bottom of the screen to perform tasks in programs. The 
command bar includes menu names, buttons, and the Input Panel button. 

• To create a new item in the current program, tap New. 
• To see the name of a button, tap and hold the stylus on the button. Drag the 

stylus off the button so that the command is not carried out.

Pop-up menus
With pop-up menus, you can quickly choose an action for an item. For example, you 
can use the pop-up menu in the Contact list to quickly delete a contact, make a copy 
of a contact, or send an email message to a contact. The actions in the pop-up menus 
vary from program to program. 

To access a pop-up menu: 
1 Tap and hold the stylus on the item that you want to perform the action on. 

2 When the menu appears, lift the stylus, then do any of the following: 

• Tap the action you want to perform. 

Tap to quickly select a program
you have recently used.

Tap to select a program.

Tap to see more programs.

Tap to customise your handheld.

New button.

Menu
names.

Buttons.

Input panel button.
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• Tap anywhere outside the menu to close the menu without performing an 
action.

Notifications
Your handheld reminds you in a variety of ways when you have something to do. For 
example, if you've set up an appointment in Calendar, a task with a due date in Tasks, 
or an alarm in Clock, you'll be notified in any of the following ways:

• A message box appears on the screen.
• A sound, which you can specify, is played.
• The LED indicator on the front panel of your handheld flashes red. 

To choose reminder types and sounds for your handheld, tap  and then Settings. In 
the Personal tab, tap Sounds & Notifications. The options you choose here are applied 
globally in your handheld. 

Tap and hold to display
the pop-up menu.

Lift the stylus and tap
the action you want.

Tap outside the menu
to close it without performing
an action.
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2 Entering data in your 
Acer n20
You can enter data into your handheld in several ways:

• Use the input panel to enter typed text, either by using the soft keyboard or 
other input method.

• Write directly on the screen.
• Draw pictures on the screen.
• Speak into your handheld’s microphone to record a message. 
• In Inbox or MSN Messenger, use the My Text function

• Use Microsoft® ActiveSync® to synchronise or copy information from your 
computer to your handheld. 
Refer to page 99 for detailed information on using Microsoft® ActiveSync®.

Using the input panel 
Use the input panel to enter information in any program on your handheld. You can 
either type using the soft keyboard or write using Letter Recognizer, Block Recognizer, 
or Transcriber. In either case, the characters appear as typed text on the screen. 

NOTE: Transcriber is available only for the English and European Acer n20 models.

To show or hide the input panel
1 Tap the Input Panel button. 

2 Tap the arrow next to the Input Panel button to see your choices.

When you use the input panel, your handheld anticipates the word you are typing or 
writing and displays it above the input panel. When you tap the displayed word, it is 

Input Panel button.

Select an input method.

Tap to see your choices.
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inserted into your text at the insertion point. The more you use your handheld, the 
more words it learns to anticipate.

To change word suggestion options
• To set word suggestion options such as the number of words suggested at 

one time, tap , Settings, Personal tab, Input, and then the Word 
Completion tab.

To type with the soft keyboard
1 Tap the arrow next to the Input Panel button, then Keyboard.

2 On the soft keyboard that is displayed, tap the keys with your stylus.

To use Letter Recognizer
With Letter Recognizer you can write letters using the stylus just as you would on 
paper.

1 Tap the arrow next to the Input Panel button, then Letter Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. 

NOTE: For specific instructions on using Letter Recognizer, with Letter Recognizer open, tap 
the question mark next to the writing area.

To use Block Recognizer
With Block Recognizer you can input character strokes using the stylus that are similar 
to those used on other devices.

1 Tap the arrow next to the Input Panel button, then Block Recognizer.

Tap here if this
is the right word.
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2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. 

NOTE: For specific instructions on using Block Recognizer, with Block Recognizer open, tap 
the question mark next to the writing area.

To use Transcriber
With Transcriber you can write anywhere on the screen using the stylus just as you 
would on paper.

NOTE: Transcriber is available only for the English and European Acer n20 models.

Unlike Letter Recognizer and Block Recognizer, you can write a sentence or more of 
information. Then, pause and let Transcriber change the written characters to typed 
characters.

1 Tap the arrow next to the Input Panel button and then Transcriber.

2 Write anywhere on the screen.

NOTE: For specific instructions on using Transcriber, with Transcriber open, tap the question 
mark in the lower right hand corner of the screen.

To select and edit typed text
If you want to edit or format typed text, you must select it first.

1 Drag the stylus across the text to select it. 

2 To cut, copy, and paste typed text:

a Tap and hold the selected words

b Tap an editing command on the pop-up menu, or tap a command on the Edit 
menu.

Writing on the screen
In any program that accepts writing, such as the Notes program, and in the Notes tab 
of Calendar, Contacts, and Tasks, you can use your stylus to write directly on the 
screen. Write the way you do on paper. You can edit and format what you've written 
and convert the information to text at a later time.
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To write on the screen
• Tap the Pen button to switch to writing mode. This action displays lines on 

the screen to help you write.

NOTE: Some programs that accept writing may not have the Pen button. See the 
documentation for that program to find out how to switch to writing mode.

To select and edit written text
If you want to edit or format written text, you must select it first.

1 Tap and hold the stylus next to the text you want to select until the insertion point 
appears.

2 Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools, then Undo and try again. 

-or-

Tap the Pen button to deselect it and then drag the stylus across the screen.

3 You cut, copy, and paste written text in the same way you work with typed text: 

a Tap and hold the selected words

b Tap an editing command on the pop-up menu, or tap a command on the Edit 
menu.

To convert writing to text
• Tap Tools and then Recognize.

If you want to convert only certain words, select them before tapping 
Recognize on the Tools menu (or tap and hold the selected words and then 

Tap the Pen button and use
your stylus like a pen.
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tap Recognize on the pop-up menu). If a word is not recognized, it is left as 
writing.

If the conversion is incorrect, you can select different words from a list of alternates or 
return to the original writing. To do so: 

1 Tap and hold the incorrect word (tap one word at a time). 

2 On the pop-up menu, tap Alternates. 

A menu with a list of alternate words appears. 

3 Do either of the following: 

a Tap the word you want to use. 

b Tap the writing at the top of the menu to return to the original writing.

NOTE:
Hyphenated words, foreign words that use special characters such as accents, and some 
punctuation cannot be converted.

If you add writing to a word to change it (such as changing a "3" to an "8") after you 
attempt to recognise the word, the writing you add will not be included if you attempt to 
recognise the writing again. 

Select the text you want
to convert and tap Recognize on the
pop-up menu.

The writing is turned into
text.
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.

Tips for getting good recognition
• Write neatly.
• Write on the lines. Write the cross of the "t" and apostrophes below the top 

line so that they are not confused with the word above. Write periods and 
commas above the line.

• For better recognition, try increasing the zoom level to 300% using the Tools 
menu.

• Write the letters of a word closely and leave big gaps between words so that 
your handheld can easily tell where words begin and end.

Drawing on the screen
You can draw on the screen in the same way that you write on the screen. The 
difference between writing and drawing on the screen is how you select items and 
how they can be edited. For example, selected drawings can be resized, while writing 
cannot.

To create a drawing
1 Cross three ruled lines on your first stroke. 

A drawing box appears. 

Or, tap the word you want
to use.

Tap to return to your
original writing.
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2 Subsequent strokes in or touching the drawing box become part of the drawing.

Drawings that do not cross three ruled lines will be treated as writing.

TIP: You may want to change the zoom level so that you can more easily work on or view 
your drawing. Tap Tools and then select a zoom level.

To select a drawing
If you want to edit or format a drawing, you must select it first.

• Tap and hold the stylus on the drawing until the selection handle appears. 
• To select multiple drawings, deselect the Pen button and then drag to select 

the drawings you want.

To edit a drawing
• To cut, copy, and paste selected drawings: 

a Tap and hold the selected drawing. 

b Tap an editing command on the pop-up menu, or tap a command on the Edit 
menu. 

• To resize a drawing: 
a Make sure the Pen button is not selected. 

b Drag a selection handle until desired size is attained.

The drawing box indicates
the boundaries of the drawing.

Pen button.
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Recording a message
In any program where you can write or draw on the screen, you can also quickly 
capture thoughts, reminders, and phone numbers by recording a message. 

• In Calendar, Tasks, and Contacts, you can include a recording in the Notes 
tab. 

• In Notes, you can either create a stand-alone recording or include a recording 
in a written note. If you want to include the recording in a note, open the 
note first. 

• In Inbox, you can add a recording to an email message. 

To create a recording 
1 Hold your handheld's microphone near your mouth or other source of sound.

NOTE: Refer to "Front view" on page 3 for the location of your handheld’s microphone.

2 Start recording by doing either of the following: 

• Press and hold (do not release) the Record hardware button on the left side 
of your handheld until you hear a beep.

• Tap the Record button on the Recording toolbar. 
3 Make your recording.

4 To stop recording: 

• Recording via Record hardware button: Release the Record button. Two 
beeps will sound. 

• Recording via the Record software button: Tap the Stop button on the 
Recording toolbar.

The new recording appears in the note list or as an embedded icon.

To play a recording
• Tap it in the list or tap its icon in the note.

Indicates an embedded
recording.

Tap to show or hide
the Recording toolbar.

Tap to begin recording.
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Using My Text
When using Inbox or MSN Messenger, use My Text to quickly insert preset or 
frequently used messages into the text entry area. 

To insert a My Text message
1 Tap My Text on the screen’s command bar. 

2 Tap a message.

NOTE: You can add text after inserting a My Text message before sending it.

To edit a My Text message
1 In the Tools menu, tap Edit and then tap My Text Messages. 

2 Select the message you wish to edit and make the desired changes.

Tap to select a
prewritten message.
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3 Managing applications 
and information 
This chapter will discuss the following topics: 

• Opening and switching between applications in your handheld
• Using File Explorer to manage files
• Using the Find function to look for a specific file

Opening an application
You can open applications by doing either of the following: 

• Tap , Programs, and then the program name. 
If you have many applications installed on your handheld, tap the scroll bar 
to see all the available applications. 

NOTE: You can customise which programs you see on the  menu. For instructions, see 
"Personal" on page 122. 

• Press any of the Quick buttons on the front panel of your handheld. 
The icons on the buttons identify the programs.

NOTE: Based on your working style and common tasks, you can reassign the Quick buttons 
to other applications on your handheld. Refer to "Personal" on page 122 for instructions. 

Switching between applications
Choose from the following options to switch between applications:

• Select another program from the  menu. 
• Press any of the Quick buttons on the front panel of your handheld. 

NOTE: Some programs have abbreviated labels for check boxes and drop-down menus. To 
see the full spelling of an abbreviated label, tap and hold the stylus on the label. Drag the 
stylus off the label so that the command is not carried out. 

The following table contains a partial list of programs that are available on your 
handheld. Refer to the Acer n20 Handheld Companion CD for additional programs 
that you can install into your handheld.  
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Icon Program Usage

ActiveSync Synchronise information between your handheld and 
your computer.

Calendar Keep track of your appointments and create meeting 
requests.

Contacts Keep track of your friends and colleagues.

Inbox Send and receive email messages.

Pocket Internet 
Explorer

Browse Web and WAP sites, and download new 
programs and files from the Internet.

Notes Create handwritten or typed notes, drawings, and 
recordings.

Tasks Keep track of your tasks.

Pocket Excel Create new workbooks or view and edit Excel 
workbooks created on your computer.

MSN Messenger Send and receive instant messages with your MSN 
Messenger contacts.

Pocket Word Create new documents or view and edit Word 
documents created on your computer.
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Finding and organising information
Use the Find function and the File Explorer window to search for specific files and 
manage your files easily.

To use Find
The Find function helps you quickly locate specific files. 

1 On the  menu, tap Find. 

2 Enter the text you want to find, then select a data type.

TIP: To quickly find information that is taking up storage space on your handheld, select 
Larger than 64 KB in Type.

3 Tap Go to start the search.

To use File Explorer
Use File Explorer to locate files on your handheld and to organise these files into 
folders. 

• On the menu, tap Programs, and then File Explorer.

Tap here to 
start search.

Type text you
want to find. 
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Tap the folder name
to open it.

Tap and hold to create
a new folder.

Select the sort order
for the list.

Tap to change folders.
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4 Managing Microsoft® 
Pocket Outlook applications

This chapter will discuss the basic applications included in the Microsoft® Pocket 
Outlook program installed in your handheld. This discussion will include: 

• Calendar - schedule meetings and remind yourself of set appointments
• Contacts - keep at hand a directory of contact information 
• Tasks - make a to-do list 
• Notes - create textual or recorded notes of your thoughts and ideas 
• Inbox - write, edit, and view your emails on the road 

You can use these programs individually or in tandem with each other. For example, 
email addresses stored in Contacts can be used to address email messages in Inbox. 

Calendar
Calendar enables you to conveniently manage your schedules and appointments or 
any other activities associated with a time and date. You can schedule appointments, 
including meetings and other events. Checking your appointments is easy using one 
of several views—Agenda, Day, Week, Month, and Year. 

NOTE: Switch view options by using the View menu. 

To open Calendar
• Press the Calendar Quick button on the front panel of your handheld.

Calendar will open to today’s schedule. 
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NOTE: You can customise the Calendar display, such as changing the first day of the week, 
by tapping Options on the Tools menu. 

Scheduling an appointment
You can use Calendar to create an appointment schedule.

To create an appointment
1 If you are in Day or Week view, tap the desired date and time for the appointment.

2 Tap New.

Tap to go to today.

Tap to display or edit
the appointment details.

Tap to create a new appointment.
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3 Using the input panel, enter a description and a location. 

Tap first to select the field. 

4 If needed, tap the date and time to change them.

5 Enter other desired information. 

You will need to hide the input panel to see all available fields.

6 To add notes, tap the Notes tab. 

You can enter text, draw, or create a recording. For more information on creating 
notes, see "Notes" later in this chapter.

7 After completing the details, tap OK. 

TIP: If you select Remind me in an appointment, your handheld will remind you according 
to the options set in , Settings, Personal tab, Sounds & Notifications. 

To use the Calendar summary screen
When you tap an appointment in Calendar, a summary screen is displayed. To change 
the appointment, tap Edit.

Tap to select a date.

Tap to select a time.

Tap to return to the calendar
(the appointment is saved
automatically).

Tap to choose from
previously entered locations.

Tap to choose from
predefined text.

Notes is a good place
for maps and directions.
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Creating a meeting request
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The 
meeting request will be created automatically and sent when you synchronise Inbox 
or when you connect to your email server. Indicate how you want meeting requests 
sent by tapping Tools and then Options. If you send and receive email messages 
through ActiveSync, select ActiveSync.

To schedule a meeting
1 Create an appointment.

2 In the appointment details, hide the input panel, and then tap Attendees.

3 From the list of email addresses you've entered in Contacts, select the meeting 
attendees. 

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see the Help menu 
of Calendar and Inbox in your handheld.

Contacts
Contacts maintains a list of your friends’ and colleagues’ contact information. Using 
your handheld’s infrared (IR) port, you can quickly share this list with other device 
users.

To open Contacts
• Press the Contacts Quick button on the front panel of your handheld.

Contacts will open to the Contacts list.

View appointment details.

View.

Tap to change
appointment.
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NOTE: To change the way information is displayed in the list, tap Tools and then Options.

Creating a contact
1 Tap New.

2 Using the input panel, enter a name and other contact information. 

You will need to scroll down to see all available fields.

Notes is a good place
for maps and directions.

Tap to return to the contact
list (the contact is saved
automatically).

Scroll to see more fields.
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3 To assign the contact to a category, scroll to and tap Categories and select a category 
from the list. 

In the contact list, you can display contacts by category.

4 To add notes, tap the Notes tab. 

You can enter text, draw, or create a recording. For more information on creating 
notes, see "Notes," later in this chapter.

5 After completing the details, tap OK. 

Finding a contact
There are four ways to find a contact: 

• In the Contact list, enter a contact name in the box under the navigation bar.
To show all contacts again, clear text from the box or tap the button to the 
right of the box. 

• In the Contact list, tap the category list (labeled All Contacts by default) and 
select the type of contact that you want displayed. 
To show all contacts again, select All Contacts. 

To view a contact not assigned to a category, select None. 

• To view the names of companies your contacts work for, in the contact list, 
tap View > By Company. 
The number of contacts that work for that company will be displayed to the 
right of the company name. 

• Tap , Find, enter the contact name, select Contacts for the type, and then 
tap Go. 

To use the Contacts summary screen
When you tap a contact in the Contact list, a summary screen is displayed. To change 
the contact information, tap Edit.
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Tasks
Use Tasks to keep track of what you have to do and prioritise them based on their 
importance and urgency. 

To open Tasks

• Tap  then, Tasks. 
Tasks will open to the Tasks list.

View contact details.

Tap to view notes.

Tap to change contact information.
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NOTE: To change the way information is displayed in the list, tap Tools and then Options.

Creating a task
1 Tap New.

2 Using the input panel, enter a description.

3 You can enter a start date and due date or enter other information by first tapping 
the field. 

If the input panel is open, you will need to hide it to see all available fields.

4 To assign the task to a category, tap Categories and select a category from the list. 

In the task list, you can display tasks by category.

5 To add notes, tap the Notes tab. 

You can enter text, draw, or create a recording. For more information on creating 
notes, see "Notes" later in this chapter.

Tap to create a new  task.

Select the sort order
of the list.

Indicates high priority.

Select the category of tasks
you want displayed in the list.

Tap to display or edit
the task details.

Tap and hold to display
a pop-up menu of actions.
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6 After completing the details, tap OK.

TIP: To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap 
Tap Here to add a new task and enter your task information.

To use the Tasks summary screen
When you tap a task in the task list, a summary screen is displayed. To change the task, 
tap Edit.

Tap to return to the task
list (the task is saved
automatically).

Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.

View task details.

View notes.

Tap to show and hide additional
summary information.

Tap to change task.
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Notes
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with 
Notes. You can create a written note or a recording. You can also include a recording 
in a note. If a note is open when you create the recording, it will be included in the 
note as an icon. If the note list is displayed, it will be created as a stand-alone 
recording.

To open Notes

• Tap  then, Notes. 
Notes will open to the Notes list. 

Creating a note
1 Tap New.

2 Create the note by writing, drawing, typing, or recording.

NOTE: For more information about using the input panel, writing and drawing on the 
screen, and creating recordings, see "2 Entering data in your Acer n20" on page 19.

Tap to open a note or
play a recording.

Tap and hold to display
a pop-up menu of actions.

Tap to create a new  item.

Tap to change the sort
order of the list.

Tap to show or hide the
Recording toolbar.

Tap to record.
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Inbox
Use Inbox to send and receive email messages by doing either of the following: 

• Synchronise email messages with Microsoft Exchange or Microsoft Outlook 
on your computer.

• Send and receive email messages by connecting directly to an email server 
through an Internet service provider (ISP) or a network.

To open Inbox
• Press the Inbox Quick button on the front panel of your handheld. 

Inbox will open to the Inbox’ folder navigator.

Tap to return to the note
list (the note is saved
automatically).

Tap to write on the screen.

Tap to show or hide
the input panel.

Tap to add a recording
to the note.



4 Managing Microsoft® Pocket Outlook applications
Inbox

44   

Synchronising email messages
Email messages can be synchronised as part of the general synchronisation process. 
You will need to enable Inbox synchronisation in ActiveSync. 

For information on enabling Inbox synchronisation, see ActiveSync Help on your 
computer.

During synchronisation:

• Messages are copied from the mail folders of Exchange or Outlook on your 
computer to the ActiveSync folder in Inbox on your handheld. By default, you 
will receive messages from the past three days only, the first 100 lines of each 
message, and file attachments of less than 100 KB in size.

• Email messages in the Outbox folder on your handheld are transferred to 
Exchange or Outlook, and then sent from those programs.

• Email messages in subfolders must be selected in ActiveSync on your 
computer in order to be transferred.

TIP: You can also synchronise email messages with your computer from a remote location. 
For more information, see the ActiveSync Help menu in your computer.

Connecting directly to an email server
In addition to synchronising email messages with your computer, you can send and 
receive email messages by connecting to an email server using a modem or a network 
card connected to your handheld. You'll need to set up a remote connection to a 
network or an ISP, and a connection to your email server. For more information, refer 
to "9 Getting connected" on page 101. 

When you connect to the email server, new messages are downloaded to your 
handheld’s Inbox folder, messages in the handheld’s Outbox folder are sent, and 
messages that have been deleted on the email server are removed from the 
handheld’s Inbox folder.
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Messages that you receive directly from an email server are linked to your email server 
rather than your computer. When you delete a message on your handheld, it is also 
deleted from the email server the next time you connect based on the settings you 
selected in ActiveSync.

You can work online or offline. When working online, you read and respond to 
messages while connected to the email server. Messages are sent as soon as you tap 
Send, which saves space on your handheld.

When working offline, once you've downloaded new message headers or partial 
messages, you can disconnect from the email server and then decide which messages 
to download completely. The next time you connect, Inbox downloads the complete 
messages you've marked for retrieval and sends the messages you've composed.

Using the Message list
The messages you receive are displayed in the Message list. By default, the most 
recently received messages are displayed first in the list.

When you receive a message, tap it to open it. Unread messages are displayed in bold.

Select the sort order
for messages.

Select the service and folder
you want to display.

Tap to connect to
the selected service.

Tap to connect and to
send and receive e-mail.

Tap to open a message.

Tap and hold to display
a pop-up menu of actions.
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When you connect to your email server, by default, you'll receive messages from the 
last five days only, the first 100 lines of each new message, and file attachments of less 
than 100 KB in size. The original messages remain on the email server or your 
computer. 

You can mark the messages that you want to retrieve in full during your next 
synchronisation or email server connection. Follow the steps below. 

1 In the Message list, tap and hold the message you want to retrieve. 

2 On the pop-up menu, tap Mark for Download. The icons in the Inbox message list give 
you visual indications of message status.

Specify your downloading preferences when you set up the service or select your 
synchronisation options. You can change them at any time:

• Change options for Inbox synchronisation using ActiveSync options. For more 
information, see ActiveSync Help.

• To change options for direct email server connections. In Inbox on your 
handheld: 
a Tap Tools and then tap Options. 

b On the Service tab, tap the service you want to change. 

c Tap and hold the service and select Delete to remove a service.

Composing a message
1 Tap New. 

2 In the To field, enter an email or SMS address of one or more recipients, separating 
them with a semicolon, or select a name from the contact list by tapping the Address 
Book button. 

All email addresses entered in the email fields in Contacts appear in the Address Book.

Tap to delete this message.

Tap to view  the previous
or next message.

Tap to reply to or
forward this message.

Tap to return to
the message list.
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3 Compose your message. 

To enter preset or frequently used messages, tap My Text and select a message.

If you are sending an SMS message and want to know if it was received, tap Edit, 
Options, and select Request SMS text message delivery notification. 

4 Tap Send when you've finished the message. 

If you are working offline, the message is moved to the Outbox folder and will be sent 
the next time you connect.

Managing email messages and folders
By default, messages are displayed in one of five folders for each service you have 
created: Inbox, Deleted Items, Drafts, Outbox, and Sent Items. 

• The behavior of the Deleted and Sent Items folders depends on the options 
you have chosen. To set these options, in the Message list: 
a Tap Tools and then Options. 

b On the Message tab, select your options.

• If you want to organise messages into additional folders, tap Tools, and then 
Manage Folders to create new folders. 

• To move a message to another folder, in the Message list, tap and hold the 
message and then tap Move to on the pop-up menu.

Tap to show or hide
the complete header.

Tap to send the message.

Tap to insert common messages.

Tap to show / hide the
recording toolbar.

Tap to display the Address Book.
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Folder behavior with a direct connection to an email server
The behavior of the folders you create depends on whether you are using ActiveSync, 
SMS, POP3, or IMAP4. 

• If you use ActiveSync, email messages in the Inbox folder in Outlook will 
automatically be synchronised with your handheld. You can select to 
synchronise additional folders by designating them for ActiveSync. The 
folders you create and the messages you move will then be mirrored on the 
server. For example, if you move two messages from the Inbox folder to a 
folder named Family, and you have designated Family for synchronisation, 
the server creates a copy of the Family folder and copies the messages into 
that folder. You can then read the messages while away from your computer.

• If you use SMS, messages are stored in the Inbox folder. 
• If you use POP3 and you move email messages to a folder you created, the 

link is broken between the messages on your handheld and their copies on 
the email server. The next time you connect, the email server will see that the 
messages are missing from the handheld’s Inbox and delete them from the 
server. This prevents you from having duplicate copies of a message, but it 
also means that you will no longer have access to messages that you move to 
folders created from anywhere except your handheld. 

• If you use IMAP4, the folders you create and the email messages you move 
are mirrored on the server. Therefore, messages are available to you anytime 
you connect to your email server, whether it is from your handheld or from 
your computer. This synchronisation of folders occurs whenever you connect 
to your mail server, create new folders, or rename/delete folders when 
connected. 
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5 Managing Microsoft® Pocket 
PC 2002 companion programs

Perform your usual computing tasks on-the-road using the Microsoft® Pocket PC 2002 
companion programs which include: 

• Pocket Word
• Pocket Excel

• MSN® Messenger

• Microsoft® Windows Media™ Player for Pocket PC

• Microsoft® Reader for Pocket PC

NOTE: Microsoft® Reader is available only for the English and European Acer n20 models. 

To open a companion program on your handheld, tap Programs on the  menu, and 
then tap the program name.

Pocket Word
Pocket Word works with Microsoft Word on your computer to give you easy access to 
copies of your documents. You can:

• Create new documents on your handheld, such as letters, meeting minutes, 
and trip reports, or you can copy documents from your computer to your 
handheld. 

• Synchronise documents between your computer and your handheld so that 
you have the most up-to-date content in both locations.

For more information on using Pocket Word, tap  > Programs > Pocket Word then, 
tap Help from the  menu.

Creating a new file 

• Tap , Programs, Pocket Word, and then New. 
A blank document appears. Or, if you've selected a template for new 
documents in the Options dialog box, that template appears with 
appropriate text and formatting already provided. 

You can open only one document at a time; when you open a second document, you'll 
be asked to save the first. You can save a document you create or edit in a variety of 
formats, including:

• Word (.doc)
• Pocket Word (.psw)

• Rich Text Format (.rtf)
• Plain Text (.txt)
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To use the Pocket Word file list
Pocket Word contains a list of the files stored on your handheld.

• Tap a file in the list to open it. 
• To delete, make copies of, and send files, tap and hold a file in the list. Then, 

select the appropriate action on the pop-up menu.

Entering information 
You can enter information in Pocket Word in one of four modes—typing, writing, 
drawing, and recording, which are displayed on the View menu. Each mode has its 
own toolbar, which you can show and hide by tapping the Show/Hide Toolbar button 
on the command bar.

If you're opening a Word document created on a computer, select Wrap to Window 
on the View menu so that you can see the entire document.

TIP: You can change the zoom magnification by tapping View and then Zoom. Then select 
the percentage you want. Select a higher percentage to enter text and a lower one to see 
more of your document.

Typing mode
• Using the input panel, enter typed text into the document. 

For more information on entering typed text, see "Using the input panel" on 
page 19.

• To format existing text and to edit text, first select the text. You can select 
text as you do in a Word document, using your stylus instead of the mouse to 
drag through the text you want to select. 

Tap to change the sort
order of the list.

Tap to open a document.

Tap and hold an item to see
a pop-up menu of actions.

Tap to create a new document.

Select the type of folder you
want displayed in the list.
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• You can search a document to find text by tapping Edit and then Find/
Replace.

Writing mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are 
displayed as a guide, and the zoom magnification is greater than in typing mode to 
allow you to write more easily.

For more information on writing and selecting writing, see "Writing on the screen" 
on page 21.

Tap to change
formatting options.

Tap to format text.

Tap and hold to see a
pop-up menu of actions.

Tap to show or hide
the toolbar.

Tap to return to the
document list (changes are
saved automatically).
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If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, 
and can be edited and manipulated as described in the following section.

NOTE: Written words are converted to graphics (metafiles) when a Pocket Word document 
is converted to a Word document on your computer.

Drawing mode
In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. 
When you lift your stylus off the screen after the first stroke, you'll see a drawing box 
indicating the boundaries of the drawing. Every subsequent stroke within or touching 
the drawing box becomes part of the drawing. 

For more information on drawing and selecting drawings, see "Drawing on the 
screen" on page 24.

With Space button selected,
drag to insert space. An arrow
appears showing the space
direction and size.

Tap to highlight selected text.

Space button.

Tap to select formatting options,
such as pen weight and line color.

Pen button.
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Recording mode
In recording mode, you can embed a recording into your document. Recordings are 
saved as .wav files. 

For more information on recording, see "Recording a message" on page 26.

Pocket Excel
Pocket Excel works with Microsoft Excel on your computer to give you easy access to 
copies of your workbooks. You can:

• Create new workbooks on your handheld, such as expense reports and 
mileage logs, or you can copy workbooks from your computer to your 
handheld. 

• Synchronise workbooks between your computer and your handheld so that 
you have the most up-to-date content in both locations.

For more information on using Pocket Excel, tap  > Programs > Pocket Excel then, 
tap Help from the  menu.

Creating a new workbook

• Tap , Programs, Pocket Excel, and then New. 
A blank workbook appears. Or, if you've selected a template for new 
workbooks in the Options dialog box, that template appears with 
appropriate text and formatting already provided. 

Select Shape on the
pop-up menu to convert
objects to proper shapes.

Resize an object by dragging
the selection handles.

Tap an arrow  to
see your choices.

Tap to select formatting options,
such as line weight, fill color, and line color.

Pen button.
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You can open only one workbook at a time; when you open a second workbook, 
you'll be asked to save the first. You can save a workbook you create or edit in a 
variety of formats, including:

To use the Pocket Excel file list
Pocket Excel contains a list of the files stored on your handheld. 

• Tap a file in the list to open it. 
• To delete, make copies of, and send files, tap and hold a file in the list. Then 

select the appropriate action from the pop-up menu.

Displaying the toolbar
Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, 
sorting, and filtering, in its toolbar.

• Tap View and then Toolbar. 

Protecting your workbooks
If your workbook contains sensitive information, you can protect it with a password. 

• Open the workbook, tap Edit, and then Password. 
Every time you open the workbook, you will need to enter the password, so 
choose one that is easy for you to remember but hard for others to guess.

Tips for working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel:

• View in full-screen mode to see as much of your worksheet as possible. 

• Pocket Excel (.pxl)

• Excel (.xls)

Cell contents appear here
as you enter them.

AutoSum button.

Format button.

Zoom button.
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– Tap View and then Full Screen. 
– To exit full-screen mode, tap Restore.

• Show and hide window elements. 
– Tap View and then tap the elements you want to show or hide.

• You might want to freeze the top and left-most panes in a worksheet to keep 
row and column labels visible as you scroll through a sheet. 
a Select the cell where you want to freeze panes. 

b Tap View and then Freeze Panes. 

• Split panes to view different areas of a large worksheet. 
a Tap View and then Split.

b Then drag the split bar to where you want it.

To remove the split, tap View and then Remove Split.

• Show and hide rows and columns. 
– To hide a hidden row or column: 

a Select a cell in the row or column you want to hide.

b Tap Format, then Row or Column, and then Hide. 

– To show a hidden row or column: 
a Tap Tools, then Go To. 

b Type a reference that is in the hidden row or column.

c Tap Format, then Row or Column, and then Unhide.

MSN® Messenger
MSN® Messenger on your handheld is an instant messaging program that lets you:

• See who is online
• Send and receive instant messages
• Have instant message conversations with groups of contacts

For more information on using MSN Messenger, tap  > Programs > MSN Messenger 
then, tap Help from the  menu.

Requirements to use MSN Messenger
• Microsoft Passport™ account or a Microsoft Exchange email account. 

• Passport to use MSN Messenger Service. If you have a Hotmail® or MSN 
account, you already have a Passport. 

Once you have obtained either a Microsoft Passport or a Microsoft Exchange account, 
you are ready to set up your account.

TIP: Sign up for a Microsoft Passport account at (http://www.passport.com/). Get a free 
Microsoft Hotmail email address at (http://www.hotmail.com/).

http://www.passport.com
http://www.passport.com
http://www.hotmail.com
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Setting up an account
Before you can connect, you must enter Passport or Exchange account information.

To set up an account and sign in:
1 In the Tools menu, tap Options.

2 In the Accounts tab, enter your Passport or Exchange account information.

3 To sign in, tap the sign-in screen and enter your email address and password.

NOTE: If you already use MSN Messenger on your computer, your contacts will show up on 
your handheld without being added again.

Working with contacts
The MSN Messenger window shows all of your messenger contacts at a glance, divided 
into Online and Not Online categories. From this view, while connected, you can chat, 
send a email, block the contact from chatting with you, or delete contacts from your 
list using the pop-up menu.

• To see others online without being seen, in the Tools menu, tap My Status 
and select Appear Offline. 

• If you block a contact, you will appear offline but will remain on the blocked 
contact's list. 

• To unblock a contact, tap and hold the contact, then tap Unblock on the 
pop-up menu.

Chatting with contacts
1 Tap a contact name to open a chat window. 

2 Enter your message in the text entry area at the bottom of the screen, or tap My Text 
to enter a preset message. 

Tap and hold to display
a pop-up menu of actions.

Tap a contact to start a chat.
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3 Tap Send.

Tips when chatting with contacts
• To invite another contact to a multi-user chat, in the Tools menu, tap Invite 

and tap the contact you want to invite.
• To switch back to the main window without closing a chat, tap the Contacts 

button. 
• To revert back to your chat window, tap Chats and select the person whom 

you were chatting with.
• To know if the contact you are chatting with is responding, look for the 

message under the text entry area.

Microsoft® Windows Media™ Player for Pocket PC
Use Microsoft® Windows Media™ Player for Pocket PC to play digital audio and video 
files (Windows Media and MP3 files) that are: 

• Stored on your handheld
• Copied from Microsoft Windows Media Player on your computer to your 

handheld
• On a network

Enter message.

Tap to send message.
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For more information about using Windows Media Player for Pocket PC, tap , and 
then tap Help.

Microsoft® Reader for Pocket PC
Use Microsoft® Reader for Pocket PC to read eBooks on your handheld. You can also 
download books from your favorite eBook Web site to your computer. Then, use 
ActiveSync to copy the book files to your handheld. The books appear in the Reader 
Library, where you can tap them in the list to open them. 

NOTE: Microsoft® Reader is available only for the English and European Acer n20 models.

Using Guidebook 
Guidebook contains all the information you'll need to use the Microsoft Reader. 

To open Guidebook: 
• Tap Help on the Reader command bar. 

-or-

• On a book page, tap and hold on the book title, and then tap Help on the 
pop-up menu.

Tap to play or pause.

Tap to stop.

Tap to play a
previous song.

Tap to skip to
the next song.

Tap to shift to
Fullscreen mode.

Tap to adjust
volume.

Indicates the progress
of the current track
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Getting books on your Acer n20
You can download book files from the Web. Just visit your favorite eBook retailer and 
follow the instructions to download the book files. 

Some sample books and a dictionary are included in the MSReader folder. This folder 
is located in the Extras folder on the Acer n20 Handheld Companion CD. 

Use ActiveSync to download the files from your computer to your handheld as 
described in the Read Me file in the MSReader folder.

Using Library
The Library is your Reader home page; it displays a list of all books stored on your 
handheld or storage card.

To open Library:
• On the Reader command bar, tap Library. 

-or-

• On a book page, tap the book title, and then tap Library on the pop-up 
menu.

Opening a book
• Tap a book title in the Library list.

Reading a book
Each book consists of a cover page, an optional table of contents, and the pages of 
the book. You can:

• Annotate the book with highlighting, bookmarks, notes, and drawings.
• Search for text and look up definitions for words.

In addition to the text, each book page includes a page number and book title.

Tap to open a book.

Tap to scroll through
the Library list.

Tap to specify
the books you

want to display
in the list.

Tap to select
a sort order.

Tap here to
navigate to

other parts of
the Reader.
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Navigation options are listed in the bottom portion of the cover page. Page through 
the book by: 

• Using the Directional pad or the Scroll wheel on your handheld
• Tapping the page number on each page

The first time you open a book, the table of contents, if there is one, will be displayed. 
Subsequently, whenever you open the book, you'll be automatically taken to the last 
page read.

Using the Reader features
Reading a book electronically gives you several options not available with paper 
books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on the 
pop-up menu, as described in the following sections. 

To search for text
1 Tap Find on the pop-up menu. 

2 Enter the word you want to search for. 

3 Tap the desired Find option. 

Reader highlights found matching text on the page. 

• To close Find, tap outside the box. 
• To return to your original page, tap the title and then tap Return on the 

pop-up menu.

To copy text 
You can copy text from books that support this feature into any program that accepts 
text. 

1 On a book page, select the text you want to copy. 

Drag to select text and
then tap an option.

Tap arrows to turn
the page, or tap and
hold page # to bring
up page riffle.

Tap to select
a navigation

option.
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2 Tap Copy Text on the pop-up menu. 

The text can be pasted into the program of your choice.

To view book annotations 
To see a list of a book's annotations, including bookmarks, highlights, text notes, and 
drawings: 

1 Tap Annotations Index on the book's cover page. 

2 Tap an entry in the list to go to the annotated page.

Bookmarks 
• When you add a bookmark to a book, a colour-coded bookmark icon appears 

in the right margin. From anywhere in the book, tap the bookmark icon to go 
to the bookmarked page.

NOTE: You can add multiple bookmarks to a book. 

Highlights

• When you highlight text, it appears with a coloured background. 

Notes

• When you attach a note to text, you enter the text in a note pad that appears 
on top of the book page. A Note icon will appear in the left margin. To show 
or hide the note, tap the icon.

Drawings 
• When you add a drawing, a Drawing icon appears in the bottom-left corner 

of the page, and drawing tools appear across the bottom of the page. Draw 
by dragging your stylus.

Removing a book
When you finish reading a book, you can delete it to conserve space on your 
handheld. If a copy of the book is stored on your computer, you can download it again 
at any time. 

1 Tap and hold the title in the Library list.

2 Tap Delete on the pop-up menu.
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6 Using third-party 
applications 
Several third-party applications are included in the Acer n20 Handheld Companion 
CD. These applications are designed to complement the functions of your handheld.  

1 Application available only for the English and European Acer n20 models.

RecentDo
Using RecentDo, you can conveniently scan a list of the most recently accessed 
programs, documents and websites. 

Documents that have been edited and saved will be listed in RecentDo as well as 
documents opened by Microsoft Media Player or PocketTV; Documents that were only 
opened and viewed will not be included. 

To launch RecentDo, simply tap its icon  on the navigation bar. 

Items in the RecentDo window are categorised into three—Programs, Documents, and 
Websites. Listed items are shown in hypertext format so you can easily launch them.

RecentDo Provides a quick way to launch the most recently accessed 
programs, documents and websites.

Backup/Restore Backs up data files and applications in your handheld’s 
internal memory to a storage card and restores them back 
when you need them.

IA Album LE Views and edits standard image files such as JPEG, BMP, and 
GIF files.

Acrobat Reader for 
Pocket PC 1

Views Acrobat Reader (.pdf) files

PocketTV Enterprise 
Edition1 

Allows playback of standard MPEG-1 files
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NOTE: Each category can contain a maximum of five items at a time.

Backup/Restore
Backup/Restore enables you to back up data files and applications in your handheld’s 
internal memory to a storage card and to restore backup data to your handheld. Your 
handheld’s expansion features allow you to use any of the following storage cards: 

• Memory Stick - via the built-in Memory Stick slot 
• CompactFlash - using the optional expansion sleeve
• PC Card - using the optional expansion sleeve

For more information on these expansion features, refer to "7 Using expansion 
features" on page 91.

During a backup or restore operation: 

• All hardware buttons are disabled as well as the automatic handheld off 
feature 

• The power button serve as a pause/resume button to control the pace of 
backup/restore operation

There are two tabs in the program window corresponding to the two function of 
Backup and Restore.
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To launch Backup/Restore:
1 Insert a storage card into the appropriate slot. 

For instructions on how to insert a Memory Stick, refer to page 91. 

If you will be using either a CompactFlash card or a PC Card, attach first your handheld 
to the expansion sleeve (optional accessory, sold separately). Refer to page 94 for 
instructions on how to attach the expansion sleeve to your handheld.

2 Tap , Programs, and then Backup/Restore.

Note that when you attempt to launch Backup/Restore without any storage card 
available in the system, option for that unavailable storage card will be disabled. 

When the selected storage card is removed during the backup or restore process, a 
warning message will pop up.
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Backup function
The Backup function has two operating modes—Normal Backup and Advanced 
Backup. In the Advanced mode, you can set to perform an automatic data backup 
when the system is running on x battery power; x being the set battery capacity 
defined in the Advanced window. 

Note that no backup procedure will be performed when the Advanced backup setting 
is activated and the specified storage card (default: Memory Stick) is not attached to 
your handheld when x battery level is reached.
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NOTE: 'AutoBackup' is the default filename of a backup file generated using the Advanced 
mode. 

To perform data backup
1 Close all running programs except for Backup/Restore.

2 In the Backup tab, choose whether to accept the default filename (backup) or type a 
new one by tapping the keyboard icon on the bottom of the screen. 

3 Select a storage card (default: Memory Stick) from the 'Backup to' radio buttons.

4 Define the backup scope (default: PIM only) from the Option' radio buttons.

If free space in the selected storage card is less than the size of the data to be copied 
from the handheld’s internal memory, a warning message will pop up.
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Tap Retry to revert to the Backup tab, then either delete files from the selected 
storage card to increase its free space or select a new storage card with a enough 
space to accommodate the size of the intended backup data. 

Refer to page 74 for instructions on how to delete a file from a storage card.

5 Tap Start to proceed with the backup process.

If a backup file of the same filename as set exists in the selected storage card, a 
pop-up message appears.
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Tap Yes to replace existing file, or tap No, then either define a new filename or select 
another storage card.

A pop-up message will appear prior to Backup initialization. 

6 Tap OK. 

During the backup process, a progress screen will appear displaying backup status.

If a locked file is encountered during backup, a warning message will pop up.
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Tap Reset to restart your handheld, then launch Backup/Restore again.

When the backup process is completed, a message box appears.

7 Tap ok.

Restore function
You can only restore backup files that are generated by Backup/Restore; file format 
is *.dbk. 

To restore backup data 
1 Close all running programs except for Backup/Restore.
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2 Select a storage card source (default: Memory Stick) from the 'Restore from' radio 
buttons.

A list of files contained in the selected storage card is displayed on the lower half of 
the screen. The filename, file size and creation of each backup file are shown. 

3 Tap a filename to select the file you wish to restore. 

If a .dbk file generated by another application is selected, a warning message will pop 
up.

Tap ok, then select a .dbk file generated by Backup/Restore.

Once a valid .dbk file is selected, the window will shift to display related file 
information including: 

• Backup file - filename of the selected .dbk file
• Created on - date when the selected .dbk file was created
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• Backup option - mode used to generate the .dbk file
• Main memory free size - free space in your handheld’s main memory. This 

should be bigger than the file size of the selected .dbk file for the restore 
process to proceed. 

4 Tap Start to proceed with the restore process.

A pop-up message of restore reminders will appear. 

5 Tap OK.

If a corrupted backup file (i.e., an error occurred during the backup process) is 
encountered during restore, a warning message will pop up.
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Tap Reset to restart your handheld, then relaunch Backup/Restore. 

If a locked file is encountered during restore, a warning message will pop up. 

Do any of the following: 

• Close the locked file then tap Retry to continue the restore process. 
• Tap Ignore to skip the locked file and continue with the restore process. 
• Tap Cancel to abort the whole restore process.
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During the restore process, a progress screen will appear displaying restore status. 

When the restore process is completed, a message box appears.

6 Tap ok.

Deleting a file from a storage card
To increase the size of available free space in a storage card, you can delete files that 
you no longer need. 

1 Tap the Restore tab. 

2 Select the storage card from which you want to delete a file. 

3 From the list, tap a filename. 
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4 From the pop-up menu, tap Delete. 

A message confirming deletion will appear.

5 Tap OK. 

IA Album LE 
IA Album LE (Lite Edition) is a convenient image viewing tool for file management, 
browsing and viewing. 

Toolbar contains different 
icons for easy access to 
frequently-used commands.

Toggles the 
toolbar display 
on and off.

Thumbnail 
View icon

Select View 
icon

Full Screen 
View icon
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Key features include:

• Built-in Screen Capture function with option to enable sound capture.
• Image viewing for BMP, 2BP, JPEG and GIF files.
• Image file and folder management capabilities. 

View and manage any image on your handheld from any source (BMP, 2BP, 
JPEG, CMYK JPEG, or GIF format), whether or not they are screen-capture 
files created by IA Album LE. 

• Image browsing and viewing modes include Thumbnail, Select, and Full 
Screen views. 

• Optimise colours for 24-bit, 16-bit, 12-bit, 8-bit, and grayscale displays.
• Crop and Save function allows you to designate any portion of an image and 

then save that portion as a new file.
• Option to: 

– Select one of your hardware buttons to function as your Capture button, 
or specify a delay-time.

– Convert an existing file to a different format (JPEG, GIF, or Bitmap) and 
resolution. 

– Save a captured screen image as a Bitmap, GIF, or JPEG file (desired 
resolution between 60 and 300 dpi). 

• Specify a Home folder and then quick-jump to that folder or any other folder 
you have accessed during the current IA Album LE session. 

IA Album LE menus
The IA Album LE’s user interface has three menus on the command bar—File, Tools, 
and View.

File menu

The File menu provides a convenient way to switch folders, create or delete folders, 
delete images, select all images in a folder, and quit the IA Album LE program. 
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Go To 
This command provides a convenient way to switch folders. Any folders accessed 
during the current IA Album LE session will be available on the menu that appears 
when you tap Go To.

You can access the Go To menu by tapping its icon on the toolbar when in Thumbnail 
view. There is also a Home command on the GoTo menu which lets you access the set 
Home folder. 

New Folder... 
This command allows you to create a new folder on your handheld that you can use to 
store images.

1 Select the folder (in the upper pane) under which you want the new folder to 
reside. 

2 Select the New Folder... command. 

3 Enter the name for the new folder in the dialog box.

This command is also on the Toolbar, and on the pop-up menu that appears when you 
tap and hold in the folder pane while in Thumbnail View mode.

Delete Folder 
This command allows you to delete an existing folder on your handheld. 

1 Select the folder you want to delete. 

2 Select Delete Folder from the File menu or the pop-up menu that appears when 
you tap-and-hold in the Folder pane when in Thumbnail View mode. 

Delete 
After you have selected one or more image files, this command becomes available. It 
allows you to permanently delete the file or files from the folder.

You can also select this command from the Toolbar, or from the pop-up menu that 
appears when you tap-and-hold in the lower pane when in Thumbnail view.

Select All 
This command selects all images in the current folder. When in Thumbnail view, you 
can also use the Select All icon on the Toolbar.

If you wish to deselect all images after multiple images have been selected, simply tap 
anywhere within an empty portion of the Thumbnail image pane.

Exit 
This command terminates the current IA Album LE session. 
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View menu 

The View menu allows you to choose view modes, display your images in various ways 
such as zoom/rotate, and view data concerning the attributes of the images. 

Thumbnail View 
Switch to Thumbnail view by selecting Thumbnail View from the View menu, or by 
tapping its icon on the toolbar. In this view, images in the current folder are shown as 
thumbnails.

You can do the following in Thumbnail view:

• Tap the upward-pointing red triangle to display an additional row of 
thumbnail images. Conversely, each time you tap a downward-pointing blue 
triangle, a row of thumbnail images will be hidden. 

• Tap the stylus on an image and then drag it to another position. 
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• Place your stylus within the edge at the far left or far right of the screen and 
then drag the stylus over the images to perform multiple selection useful in 
mass-editing such as Delete.

• Press your handheld’s Directional pad right or down to select the next 
thumbnail image in the current folder. Pressing it left or up will select the 
previous thumbnail. 

• Double-tap an image to switch to Select view, with the tapped thumbnail 
shown as the enlarged image. 

Select View 
Switch to Select View mode by doing any of the following: 

• Double-tap an image while in Thumbnail View mode.
• Tap the Select View command from the View menu.
• Tap the Select View icon on the toolbar.
• Press the Directional pad on your handheld.  

The selected image will be enlarged. 

You can do the following in Select view:

• Press your stylus on an image that does not fit in the display area in its 
entirety and drag it in the desired direction to pan the image.

• Press your handheld’s Directional pad right to display the next image in the 
current folder. Pressing it left will display the previous image.

• Press your handheld’s Directional pad up to zoom in on the currently 
displayed image, or press down to zoom out.

A different toolbar appears in Select view. This toolbar provides convenient access to 
ten of the more common commands for Select view. To learn the function of any 
toolbar icon, press your stylus on the icon to view its tool tip.

Full Screen View 
Activate the Full Screen view by doing any of the following: 

• Select the Full Screen View command from the View menu. 
• Tap the Full Screen View icon on the toolbar.
• Press in the center of your handheld’s Directional pad.

In this view, the selected image is maximized so that the entire screen is used to 
display it. If you tap on an image while in Full Screen View, you will be returned to the 
previous view mode. 

You can do the following in Full Screen view

• Press your handheld’s Directional pad right to display the next image in the 
current folder. Pressing it left will display the previous image.

• Press your handheld’s Directional pad up to zoom in on the currently 
displayed image, or press down to zoom out.

Previous/Next Image 
These two commands (and the Previous Image icon on the toolbar) are only available 
in Select view. It selects the image previous to, or next to the current image 
(sequentially in the current folder) for display. 

Zoom In/Zoom Out
This command (and the Zoom In icon—the left-most icon on the toolbar for Select 
View) is only available in Select view. Each time you select this command, the current 
image is incrementally magnified or reduced. 
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Actual Size 
This command (and the Actual Size icon on the toolbar) is only available in Select view. 
When you select this command, the current image will be displayed in its actual size; 
that is, a one-to-one pixel ratio.  

Auto Rotate 
If this command is selected, images will automatically be displayed in the most 
appropriate orientation on the screen. If active, a check mark will be shown to the left 
of the command name on the View menu. 

Image Info... 
Use this command to view various image attributes, folder information, and system 
resource usage status. To do so, select an image and then tap Image Info... on the 
View menu.  

The Image Info screen consists of the Image, Size, Folder, and System tabs. When you 
finished viewing the info, click OK in the upper right corner of the screen. 
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TIP: The Image Info feature is also available on the Toolbar in the form of an icon. When an 
image is being displayed in its Actual Size in Select View mode, the Image Info icon is shown 
as "1:1" instead of its standard appearance (the letter "i" inside a blue circle). 

Tools menu 

The Tools menu is where you set up your preferences for Screen Capture and general 
IA Album LE behaviors. It also allows you to crop an image, save it in a different 
format, send via infrared beaming, and access the main Help contents. 

Crop... 
This command allows you to specify a portion of a file and then save that portion of 
the file to a new individual file.You can also save a file to a different format and/or 
location. To do any of these options, select the image you want to crop (in either 
Thumbnail View or Select View) and then select Crop... from the Tools menu (or the 
Crop icon on the Toolbar). A thumbnail image will be shown in the Crop tab.
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Crop tab 

In the Crop tab, you can drag your stylus on the image to manually specify a square/
rectangular area, or you can specify values in the X and Y (origin) and W and H (area) 
fields. After a Crop region has been defined, you can drag it around using your stylus.  
You can also Pan or Zoom In/Out using the icons in the Crop tab. 

To save the cropped portion as a new file immediately to the same file type as the 
original, tap the Crop button. The default file-naming convention appends an 
underscore and a "c" ( _c ) prior to the extension, and places it in the current folder. 

Format tab 

Use the Format tab to save a cropped image to a different file type and/or resolution. 
You can save the file in .jpeg, .gif, or .bmp format.  

Depending on which format you choose, Quality and Color choices will also be 
available. You also have the option to save the image at a different resolution. 

Location tab 

Use the Location tab to save a cropped image under a different folder. You also have 
the option to change the filename. 

Capture Settings... 
This command allows you to set any of your handheld's hardware buttons to act as a 
"capture" button. By simply pressing the capture button that you have designated, 
whatever is currently displayed on your handheld screen will be saved as an image 
file. 

Setting and configuring a "capture" button

1 Tap Capture Settings... on the Tools menu, or its icon on the toolbar.
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2 Make sure the Enable Screen Capture check box is checked. 

3 In the Perform capture using field, select the desired button or time-delay from the 
drop-down list.  

If you select a button, that button on your handheld will be used as your Screen 
Capture button. The buttons in the drop-down list refer to the hardware buttons on 
your handheld. 

If you select a Delay Time value from the list, the screen capture will take place after 
the chosen number of seconds passes. 

4 In the File resolution field, you can select a different predefined resolution from the 
drop-down list box.  

Your screen captures will be saved to the resolution you choose in this field. However, 
you cannot change the resolution if you choose to save screen captures in the GIF 
format.

5 Choose whether or not you want a confirmation screen to appear each time you 
create a screen-capture file.  

By default, the Confirm before file saving check box is selected. If you remove the 
check from this check box, the screen capture process will take place immediately with 
no confirmation. 

6 Choose whether or not you want to trigger a sound each time you perform a screen 
capture. If so, check the Enable capture sound check box. 

7 If you want to specify a different folder in which to save the screen-capture file, tap 
the Change... button next to the Folder field and select the desired folder in the 
screen that appears. 

NOTE: In the bottom half of the screen, the default location for the screen-capture file—
\My Documents folder is automatically specified. 

8 If you want to specify a different filename prefix or suffix, tap the Change... button 
next to the Filename field and make the desired change. 
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NOTE: In the bottom half of the screen, a default filename for the screen-capture file is 
automatically specified. By default, the name iasnap001 will be given to the first screen-
capture file, the next screen-capture file would be sequentially named iasnap002, etc. 

9 Specify the desired format in the Select the capture file format field. When finished, 
tap OK in the upper right corner. This will return you to the previous screen

By default, screen-capture files will be saved in the Bitmap (.bmp) format. You can 
optionally choose to save screen-capture files in the .jpeg or .gif format. 

• JPEG format is suitable for saving a screen on which a photo or video is 
displayed.  

• GIF can produce the smallest file size when used to store regular screen shots.
10 Tap OK. 

Capturing screens 

As long as the Enable Screen Capture check box is selected, and IA Album LE is 
running (even in the background), you can perform a screen capture anytime you 
want by simply pressing the "capture" button you have specified. When IA Album LE 
is not running, the original function of that handheld button will be restored. 

Send via Infrared... 
This command allows you to send a selected file to another IR-enabled device via 
infrared beaming, without having to leave the IA Album LE screen.  

After the receiving device has started its "Receive via Infrared" process, tap Send via 
Infrared.... You will have approximately 30 seconds in which to line up the infrared 
port of your handheld with the infrared port of the receiving device. 

Options... 
Tapping Options... on the Tools menu, or its icon on the Toolbar, opens a screen that 
contains settings for colour dithering, auto-rotation, size of thumbnail images, and 
your Home folder.
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• Color optimization 
The choices in the Color optimization drop-down list are related to the 
output fidelity of the images displayed on your handheld. If you have an 
8-, 12-, or 16-bit colour handheld, you should select the appropriate item 
from the list so that IA Album LE can map the images to the corresponding 
colour resolution. This will enable IA Album LE to perform optimum dithering 
in the event that an image contains a colour that is not supported by your 
handheld screen.  

The default setting is Automatic meaning IA Album LE will do its best to 
detect your handheld's display capabilities and automatically optimise 
colours.  If the None setting is enabled, no colour optimisation will be 
performed meaning the image will be displayed in its original form. 

• Auto rotate 
The Auto rotate function controls whether the intelligent 90-degree rotation 
will occur to the Left or to the Right when in Full Screen view. This function is 
activated when the Auto Rotate command on the View menu is selected.

• Thumbnail size 
The Thumbnail Size function controls whether thumbnail images are 
displayed in Large or Small size, both in Thumbnail and Select views. Default 
setting is Small.

• Home
By default, the Home folder is set to the \My Documents folder. You can 
change the Home folder to any folder. Follow the steps below: 

1 Select Options... from the Tools menu. 

2 Tap the Change... button in the Home field.

Acrobat Reader for Pocket PC
Acrobat® Reader® for Pocket PC® lets you view Adobe Portable Document Format 
(PDF) files from your handheld. This application includes two components: 

• The ActiveSync® filter runs on the Windows platform. It prepares untagged 
Adobe PDF files and transports them to your handheld. 

• The Reader is an application in your handheld designed to accommodate the 
characteristics of small-screen devices.

Acrobat Reader for Pocket PC allows you to view Adobe PDF files in two modes: 

• View the Adobe PDF file exactly as intended
• View a tagged Adobe PDF file in a reflowed format. This provides the best 

reading experience on your handheld because text and images are shown in 
a 'fit-the-screen' mode. 

Refer to (http://www.adobe.com/products/acrobat/readerforppc.html/) for more 
information.
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PocketTV Enterprise Edition
PocketTVTM Enterprise Edition allows you to play back standard MPEG-1 video files (i.e. 
extension .mpeg, .mpe or .mpg) as well as MPEG-1 video elementary streams (i.e. 
video only, no audio), with extension .m1v.

The program also supports .m1u files (MPEG-1 URL). These are text files that contain 
the URL of an MPEG file. These files can be used to trigger streaming from web pages. 
For more information, see (http://www.pockettv.com/html.html/). 

NOTE: PocketTV can be launched from the File Explorer, by tapping an MPEG file.

For more information on PocketTV usage and troubleshooting, see 
(http://www.mpegtv.com/wince/pockettv/faq.html/).

Command bar
The Command bar contains the usual media player commands including:

• Stop
• Play
• Pause
• Step
• Fast-forward
• Volume control
• Mute
• Repeat (loop)
• Open file

• Fullscreen/Landscape switch 
PocketTV automatically detects the 
screen orientation when a third-
party Landscape driver is used 
(JSLandscape or Nyditot Virtual 
Display).

TIP: You can also tap on the video to switch 
between normal mode and Fullscreen/
Landscape mode.
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Seek/Progress bar
Allows you to control display pace and shows the playback progress.
 

Status bar 
Shows time information (estimated time elapsed, estimated total play time), fps 
indicator (actual frames-per-second) and bit-rate indicator.
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Tools menu

Includes the following commands: 

• Open Select a file to open. 

There are two possible ways to open a file, depending 
on whether the option Options > Files > Open With 
tGetFile is selected or not.

If selected, you can open a file located anywhere; 
otherwise it uses the standard Microsoft dialog which 
only shows the files located in '\My Documents\' and in 
one level of subfolders.

• Open URL Specify an http URL for streaming. 

Built-in streaming protocols include http and ftp.

• Save Frame Capture and save the current frame. 

The frame is saved in RGB 'Targa' format and can be 
viewed or converted using the popular PQView image 
viewer.

• Properties Show the file parameters.

• Options Refer to the following subsection for details on this 
Tools command.

• About Show copyright and registration information.

• Exit Terminate the application.  

This is different from the (X) 'Smart Minimize' button,
which merely deactivates PocketTV and pushes it back 
to the background.
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Options menu command 

Some menu commands under Options also have their own set of sub-commands.

• Audio Audio Channels: Stereo, Mono (left), Mono (right)

Audio Quality: High, Medium, Low

Swap Left/Right

• Size Auto - fit screen if video is larger than screen

Nominal - fit screen if video is smaller than screen

Fit screen

• Fullscreen 90 deg Left

90 deg Right

Auto at Play - switch to Fullscreen when it starts playing

Always when Playing - links play mode with Fullscreen

Video Output: Normal, Voyager VGA, Presenter-to-go 
VGA

• Color Adjust - opens the Color Adjustment dialog.  

You can adjust the Brightness (Gamma), Contrast, Color 
(saturation) and colour balance (red, green and blue 
gamma).  

There are options to set each individual value to neutral 
or default (i.e. adjusted for optimum quality). 

NOTE: The Default and Neutral options act on all the 
values.
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• Files Play at Open - file is in automatic playback mode when 
opened. 

Microdrive - additional buffering is use to reduce 
battery usage when playing from a hard drive or 
Microdrive.

Open with tGetFile - change the format of the Open 
File dialog.

Save with tGetFile - change the format of the Save 
Frame dialog.

Remember Last - last opened file before exiting 
PocketTV is automatically displayed on the next session.

File Association - check file association.  

NOTE: If a PocketTV file association was modified by 
another application, you have the option to restore it.
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7 Using expansion 
features
The slim and lightweight design of your Acer n20 belies the impressive expansion 
features that it is capable of. These expansion features include the following: 

• Integrated Memory Stick slot 
• Acer Versatile Connector
• Expansion sleeve (optional)

These expansion features allow you to: 

• Install additional applications 
• Increase system memory
• Perform backup procedures 
• Use a variety of peripheral devices 
• Connect to the Internet or to a network

NOTE: Before using any peripheral device with your handheld, refer to the documentation 
that accompany each device for information on how to install and operate it. 

Memory Stick
On the top of your handheld is a Memory Stick slot. This allows you to expand your 
handheld memory and perform data backup. 

Refer to "Top view" on page 6 for the location of the Memory Stick slot.

For instructions on how to use a Memory Stick to perform data backup, refer to 
"Backup/Restore" on page 64.

To learn more about Memory Stick, please go to (http://www.memorystick.org/).

Inserting a Memory Stick
1 Hold your handheld securely. 
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2 Insert the Memory Stick into the Memory Stick slot. 

3 Push the card into the slot using your finger until you feel the card lock and hear an 
audible system sound; this will signal that the card is already properly seated within 
the slot. 

Removing a Memory Stick
1 Hold your handheld securely. 

2 Release the card from the slot by using your finger to push against the top of the card, 
as if you were pushing it further into the slot (a). An audible system sound will signal 
that the card has been released. 

3 Gently remove the card from the slot (b). 
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Acer Versatile Connector
Acer has adopted the use of a standard connector interface—the Acer Versatile 
Connector, on its handheld line. This interface allows you to easily attach and use 
peripheral hardware devices as a modem, a portable keyboard or a Global Positioning 
System (GPS) receiver. You can also use the Versatile Connector to take advantage of 
the existing line of accessories available for the Acer s10 Handheld series including the 
Travel Charger and the USB Sync Charge Cable. 

Refer to "Front panel" on page 2 for the location of the Acer Versatile Connector.

Expansion sleeve 
The expansion sleeve is an optional accessory designed for users who demand more 
features and functions.  It combines the ultimate flexibility in expansion, increase 
battery capacity, and adds more functionality, all in a simple and portable design. 

The illustration below shows the components of the expansion sleeve.

No. Component Usage

1 PC Card Type II slot Accepts PC Card-based peripheral devices.

2 PC Card Type II slot 
eject button

Press to pop-out any installed PC Card-based device.
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Attaching your Acer n20 to the expansion sleeve
1 Detach the removable battery pack from your handheld (a). 

Refer to "To uninstall the battery pack" on page 9. 

IMPORTANT: After removing the battery pack, you have about 30 minutes to attach the 
expansion sleeve and turn the handheld back on, otherwise you risk losing all data on the 
internal memory of your handheld. 

2 Align the handheld’s rear panel to the expansion sleeve then, slide it in through the 
sleeve’s arms (b).

3 Gently push your handheld downward until you feel it lock. 

4 Slide the battery release switch on the handheld to Lock position.

3 CompactFlash Type II slot Accepts CompactFlash-based peripheral devices.

4 CompactFlash Type II slot 
eject button

Press to pop-out any installed CompactFlash-based 
device.

5 100-pin expansion slot Connects the expansion sleeve to your handheld. 

6 USB host connector Accepts USB peripheral devices.

7 Power socket Connects to the AC adapter to provide external 
power supply to the system

No. Component Usage
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Using the expansion sleeve
Both the CompactFlash and PC Card slots are flexible expansion features that allow 
you to use a wide range of peripheral devices with your handheld. These may include: 

These two expansion slots also allow you to use a wide selection of products for 
notebook computers making your handheld an ideal mobile buddy for your laptop 
computer.

For instructions on how to use a CompactFlash card or a PC Card to perform data 
backup, refer to "Backup/Restore" on page 64.

To learn more about CompactFlash and PC Card, refer to 
(http://www.compactflash.org/) and (http://www.pc-card.com/) respectively.

The extra capacity battery function of the expansion sleeve system provides your 
handheld with increased battery capacity to cope up with the more power-
demanding applications. 

With the standard USB host connector you can easily attach USB peripheral devices to 
your handheld without consuming precious system resources. The expansion sleeve 
can readily support USB keyboards. For other USB devices, operation will depend on 
driver availability. 

Inserting a CompactFlash card
1 Hold your handheld securely. 

2 Insert the CompactFlash card into its corresponding slot on the expansion sleeve. 

• Hard drives 
• Memory cards 
• VGA (Video Graphics Array) 

cards
• Cellular phone interface
• GPS (Global Positioning 

System) cards 

• Modem cards 
• Modem and Ethernet 

combination cards 
• 100 Mbps Ethernet adapters 
• Ethernet LAN adapters
• Infrared wireless LAN 

adapters
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3 Push the card into the slot using your finger until you feel the card lock. 

Removing a CompactFlash card
1 Hold your handheld securely. 

2 Press the slot eject button to pop out the card (a); then gently remove it from the slot 
(b). 

Inserting a PC Card
1 Hold your handheld securely. 

2 Insert the PC Card into its corresponding slot on the expansion sleeve. 

3 Push the card into the slot using your finger until you feel the card lock. 
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Removing a PC Card
1 Hold your handheld securely. 

2 Press the slot eject button to pop out the card (a); then gently remove it from the slot 
(b). 
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8 Exchanging and updating 
data using ActiveSync®

Using ActiveSync®, you can synchronise information in Microsoft Outlook or Microsoft 
Exchange on your computer with your handheld. You can also synchronise this 
information directly with a Microsoft Exchange server. Each time you synchronise, 
ActiveSync compares the changes you made on your handheld and computer or server 
and updates both locations with the latest information. For example:

• Keep Pocket Outlook data up-to-date by synchronising your handheld with 
the Microsoft Outlook data on your computer. 

• Synchronise Microsoft Word and Microsoft Excel files between your handheld 
and your computer. Files are automatically converted to the correct format.

By default, ActiveSync does not automatically synchronise all types of information. 
Use ActiveSync options to turn synchronisation on and off for specific information 
types.

NOTE: If you have a wireless LAN card, you can synchronise remotely from your handheld. 
For the Acer n20w model, you can use the built-in IEEE 802.11b WLAN adapter.

For information on using ActiveSync, see ActiveSync Help on the your computer.

You can also use ActiveSync to:
• Back up and restore your handheld data. 
• Copy (rather than synchronise) files between your handheld and your 

computer. 
• Control when synchronisation occurs by selecting a synchronisation mode.

For example, you can synchronise continually while connected to your 
computer or only when you choose the synchronise command.

• Select which information types are synchronised and control how much data 
is synchronised. 
For example, you can choose how many weeks of past appointments you 
want synchronised.

Before you begin synchronisation, install ActiveSync on your computer from the 
Acer n20 Handheld Companion CD. 

NOTE: ActiveSync is already installed on your handheld.

For instructions on installing ActiveSync, see "Installing the Microsoft® ActiveSync® 
software" on page 7 or you could refer to the Just for Starters... poster included in the 
package contents. 

For detailed information about using ActiveSync on your computer, start ActiveSync 
on your computer, and then see ActiveSync Help.
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To open ActiveSync on your handheld

• Tap , and then tap ActiveSync. 

To remotely synchronise your handheld 

1 Tap , and then ActiveSync. 

2 In the Tools menu, tap Options. 

3 In the PC tab, select Include PC when synchronising remotely then select your 
computer's name. 

Remote synchronisation with a computer will work only if you have set up a 
partnership with that computer through ActiveSync and have set ActiveSync to allow 
remote connections. Other restrictions apply. 

For more information on synchronising remotely, see ActiveSync Help on the your 
computer.

Tap to connect and synchronize.

View synchronization status.

Tap to synchronize via IR or
change synchronization settings.

View connection status.

Tap to stop synchronization.
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9 Getting connected
You can use your handheld to exchange information with other mobile devices and 
connect to your computer, a network, or the Internet. You have the following 
connection options:

• Use the infrared (IR) port on your handheld to send and receive files from 
another IR-enabled device. 

• Use the built-in IEEE 802.11b WLAN adapter to connect to an existing IEEE 
802.11b wireless network (applicable only to the Acer n20w handheld 
model).

• Connect to your Internet service provider (ISP). Once connected, you can send 
and receive email messages by using Inbox and view Web or WAP pages by 
using Microsoft® Pocket Internet Explorer. 
The communication software for creating an ISP connection is already 
installed on your handheld. Your service provider will provide software 
needed to install other services, such as paging and fax services. 

• Connect to the network at your company or organisation where you work. 
Once connected, you can send and receive email messages by using Inbox, 
view Web or WAP pages by using Microsoft® Pocket Internet Explorer, and 
synchronise with your computer. 

• Connect to your computer to synchronise remotely. Once connected, you can 
synchronise information such as your Pocket Outlook information. 

Infrared communication
Using infrared, you can send and receive information, such as contacts and 
appointments from another IR-enabled device.

Refer to "Front view" on page 3 for the location of your handheld’s IR port.

Sending information
1 Switch to the program where you created the item you want to send and locate the 

item in the list.

2 Align the IR port of your handheld with that of the IR-enabled device so that they are 
unobstructed and within a close range.

3 Tap and hold the item, and then tap Beam Item on the pop-up menu.

-or- 

Send items (but not folders) using File Explorer. 

• Tap and hold the item you want to send and then tap Beam File on the 
pop-up menu.
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Receiving information
1 Align the IR port of your handheld with that of the IR-enabled device so that they are 

unobstructed and within a close range. 

2 Have the owner of the other device send the information to you. Your handheld will 
automatically receive it.

Wireless communication 
Applicable only to the Acer n20w model, this feature uses a built-in IEEE 802.11b 
WLAN adapter to connect to an existing IEEE 802.11b wireless network. This feature 
provides you with an Internet experience that is completely mobile to meet your 
fast-paced lifestyle, and with a high-speed transmission rate of up to 11 Mbps you’re 
sure to be always wired to the information highway.
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Activating the wireless feature 

1 Tap , Settings. 

2 Tap the System tab, then the Wireless LAN Utility icon.

Configuring the wireless settings
To view and modify the IP address and server-related settings:

1 Tap , Settings. 

2 Tap the Connections tab, then the Network Adapters icon. 

3 Select IEEE 802.11b WLAN Adapter from the list, then tap the Properties button.

IP Address page 
Use this page to view and edit the IP address, the subnet mask and the default 
gateway settings. 

You can use a server-assigned IP address or you can set a specific one. 

• IP address (Internet Protocol address)
This is a numeric address that the domain name server translates into a 
domain name. Each node on the IP network has a unique IP address. 

• Subnet mask
A number used to identify a sub-network when multiple networks share a 
common IP address.

• Default gateway
This is a device used to forward IP packets to and from a remote destination. 



9 Getting connected
Wireless communication

104   

Name Servers page
Use this page to view and edit the DNS, Alt DNS, WINS and Alt WINS settings. 

• DNS (Domain Name System)
This is a database system that translates IP addresses to domain names. For 
example, an IP address like 232.245.021.54 can correspond to the domain 
name http://jtl.com. This system is also used to control Internet email delivery. 

• Alt DNS (Alternative DNS)
Used to substitute the main DNS when necessary. 

• WINS (WindowsTM Internet Naming Service)
This service has two functions. First, the Microsoft® Net BIO name server 
eliminates the broadcasts needed to resolve the computer names to IP 
addresses by providing a cache or database of translations. The other 
function sets the IP address of the host computer you used when you set up 
the wireless utility for wireless ActiveSync operation.

NOTE: You need to set the IP address of the host computer to perform wireless 
synchronisation between your handheld and your host computer. 

• Alt WINS (Alternative WINS)
Used to substitute the main WINS when necessary.

Configuring the WLAN utility

1 Tap , Settings. 

2 Tap the System tab, then the WLAN icon.
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Link page
Use this page to view the SSID, Channel, TxRate, BSSID, IP Address, Subnet Mask and 
Gateway settings.

• SSID (Service Set Identifier)
This is a unique case-sensitive name of up to 32 characters shared among all 
devices sharing a common wireless network. The name value is set in Scan 
page with the default value being 'ANY'. 

• Channel
Displays the current channel used for Access Point or 802.11 Ad Hoc stations. 

• TxRate
Displays the current data transmission rate. 

• BSSID (Basic SSID)
Displays the current BSSID selected for Access Point or 802.11 Ad Hoc 
networks. When your handheld is not connected to a wireless network, the 
BSSID value would be 'Non-associated'. You can view the BSSID list in the 
Scan page.

• IP Address
Displays the current IP address. 

• Subnet Mask
Displays the current subnet mask. 

• Gateway
Displays the IP address of the current gateway.
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Configuration page
Use this page to set the Mode, SSID, Channel and Country settings, and to view the 
Link Quality indicator. 

• Mode
Select the operating mode. 

– Infrastructure - This is the default mode. It allows transmission and 
reception of data to and from an Access Point (AP) cell. It also enables 
roaming between AP cells in the network.

– 801.11 Ad Hoc - This mode allows the formation of a local network 
where adapters using a shared SSID communicate peer-to-peer without 
going through Access Points.

• SSID
This is a unique case-sensitive name of up to 32 characters shared among all 
devices sharing a common wireless network. You will be able to connect to 
an Access Point with the same SSID. 

When operating under the 801.11 Ad Hoc mode, the SSID must be the same 
among stations so that computers can communicate properly within the LAN. 

• Channel
Under the 801.11 Ad Hoc mode, the first station forms the 801.11 Ad Hoc 
network by selecting the initial SSID and channel. Other stations will only 
need to have the same SSID to join the network. 

• Country
Select the country where you are located. Different countries have different 
wireless regulations.

• Rescan. 
Tap this button to search for the nearest Access Point. 

• Radio On/Off: 
Tap this button to turn your adapter’s radio on or off. 
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• Link Quality.
This icon indicates the clarity of your handheld’s connection to the Access 
Point. 

Advanced page
Use this page to view and set the WEP, Transmission Rate, and Power Saving Mode 
settings. 

• WEP (Wired Equivalent Privacy)
Select the WEP mode, key ID and key.

Mode options:

– Disable - This is the default mode. Choose this mode when security issue 
is of no concern. This mode increases the rate of data transmission.

– 64 bits (ASCII) 
– 128 bits (ASCII) 
– 64 bits (HEX) 
– 128 bits (HEX) 

Key ID options:

When you enable one of the ASCII or HEX WEP modes, the Key ID setting 
would automatically be enabled as well. You must choose 'Key ID’ for 
connection with an AP or peer site station. You can choose 'Key 1' to 'Key 4' 
for your personal use. 

Key options:

When you enable one of the ASCII or HEX WEP modes, the Key setting would 
automatically be enabled as well. You have to enter the WEP key characters 
manually.

– 64 bits (ASCII) - requires 5 ASCII characters with no limitation
– 128 bits (ASCII) - requires 13 ASCII characters with no limitation
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– 64 bits (HEX) - requires 10 hexadecimal numbers with an upper limit of 10 
hexadecimal value from 0-9 and from (A)-(F). 

– 128 bits (HEX) - requires 26 hexadecimal values with an upper limit of 26 
hexadecimal numbers from 0-9 and from (A)-(F). 

NOTE: For HEX keys, when you enter an out-of-range character, you will be prompted to 
enter the correct character. 

• Transmission Rate
Select a transmission rate option.

– Fixed 1 Mbps
– Fixed 2 Mbps
– Fixed 5.5 Mbps
– Fixed 11 Mbps
– Auto Select 1 or 2 Mbps
– Fully Auto - Choose this option to automatically adjust the transfer speed 

(recommended). 
• Power Saving mode

Select or clear the check box to enable or disable the power saving mode. 
When you are in the 802.11 Ad Hoc mode, you cannot enable the power 
saving mode. 

Scan page
Use this page to scan and select available Access Point and 802.11 Ad Hoc networks. 

• Rescan
Tap this button to view all available 802.11 networks. 
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• BSSID/SSID
A wireless network is identified by its BSSID and SSID. Double-tap an item in 
the BSSID column to select the AP/801.11 Ad Hoc network you want to 
connect to. The Link page of the selected network will be displayed.

When operating under the 801.11 Ad Hoc mode, the SSID must be the same 
among stations so that computers can communicate properly within the LAN. 

• Signal
Percentage values indicate the signal strength of AP.

• Channel
Indicates which channel is set to be used by the network. 

• Encryption
Indicates whether encryption is enabled or disabled in the selected network.

Info page
Use this page to view the MAC address and version information of your handheld’s 
wireless utility. 

• MAC (Media Access Control) Address 
This refers to the physical address of a device connected to a network 
expressed as a 48-bit hexadecimal number. 

• Version Information
Includes version information for your handheld’s firmware, driver and 
wireless utility. 



9 Getting connected
Connecting to the Internet

110   

Connecting to the Internet
You can connect to your ISP, and use the connection to send and receive email 
messages and view Web or WAP pages.

You can connect to the Internet in one of two ways:

• Create a modem connection. 
If this is the method you want to use, see "To create a modem connection to 
an ISP" later on this page.

• Use an Ethernet card and a net tap to connect to the network. 
If this is the method you want to use, see "To create an Ethernet connection 
to an ISP" on page 111.

You can use either an Ethernet PC Card or a CompactFlash Ethernet card. 
Either way, you will need to use an expansion sleeve (optional accessory) to 
make the connection.

To create a modem connection to an ISP
1 Obtain the following information from your ISP: 

• ISP dial-up access telephone number
• User name and password

Some ISPs require information in front of the user name, such as MSN/
username.

• TCP/IP settings
2 If your handheld does not have a built-in modem, install a modem card, or use a NULL 

modem cable and appropriate adapters to connect an external modem to your 
handheld through the Versatile Connector.

3 Tap  and then Settings. 

4 In the Connections tab, tap Connections. 

5 Under The Internet settings, select Internet Settings and tap Modify.

6 In the Modem tab, tap New.

7 Enter a name for the connection, such as "ISP Connection".

8 In the Select a modem list, select your modem type. 

If your modem type does not appear, try re-inserting the modem card. If you are using 
an external modem that is connected to your handheld with a cable, select Hayes 
Compatible on COM1.

9 You need not change any settings in Advanced. Most ISPs now use a dynamically-
assigned address. If the ISP you are connecting to does not use a dynamically-assigned 
address, tap Advanced and then the TCP/IP tab, and enter the address. When finished, 
tap OK and then Next.

10 Enter the access phone number, and tap Next.

11 Select other desired options, and tap Finish.

12 In the Dialing Locations tab, specify your current location and phone type (most 
phone lines are tone). These settings will apply to all connections you create
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To create an Ethernet connection to an ISP
You do not need to create a new connection on your handheld. Instead, you must 
purchase and configure an Ethernet card that is compatible with your handheld. 

1 Obtain the following information from your ISP: 

• User name and password
• Domain name

2 Connect the expansion sleeve to your handheld.

3 Insert the Ethernet card into the appropriate slot in the expansion sleeve. 

The first time you insert the card, Network Settings will appear automatically so that 
you can configure the Ethernet card. Most networks use DHCP, so you need not 
change these settings unless your network administrator instructs you to do so. 

NOTE: If Network Settings does not appear or you wish to change settings later, tap  
and then Settings. On the Connections tab, tap Network Adapters, tap the adapter you want 
to change, and then tap Properties.

4 Tap OK. 

5 Connect the Ethernet card to the network by using a network cable. 

NOTE: For instructions on inserting and using the Ethernet card, see the documentation 
that came with the card.

6 Tap , Settings, Connections tab, and then Connections. 

7 From the My network card connects to list, select Internet. 

Connecting to a network
If you have access to a network at work, you can send email messages, view Intranet 
pages, synchronise your handheld, and possibly access the Internet. You can connect 
to a network in one of two ways:

• Create a modem connection by using a RAS account. 
Before you can create this modem connection, your network administrator 
will need to set up a RAS account for you. If this is the method you want to 
use, see "To create a modem connection to a network" later on this page. 
Your network administrator may also give you VPN settings.

• Use an Ethernet card and a net tap to connect to the network. 
If this is the method you want to use, see "To create an Ethernet connection 
to a network" on page 112.

You can use either an Ethernet PC Card or a CompactFlash Ethernet card. 
Either way, you will need to use an expansion sleeve (optional accessory) to 
make the connection.
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To create a modem connection to a network
1 Get the following information from your network administrator:

• Dial-up access telephone number
• User name and password
• Domain name
• TCP/IP settings

2 If your handheld does not have a built-in modem, install a modem card.

3 Tap  and then Settings. In the Connections tab, tap Connections. Under The 
Internet settings, select Internet Settings and tap Modify.

4 In the Modem tab, tap New.

5 Enter a name for the connection, such as "Company Connection".

6 Follow steps 8 to 12 on page 110.

To create an Ethernet connection to a network
You do not need to create a new connection on your handheld. Instead, you must 
purchase and configure an Ethernet card that is compatible with your handheld. 

1 Follow steps 1 to 6 on page 111. 

2 From the My network card connects to list, select Work. 

Starting a connection
To start the connection, simply start using one of the following programs. Your 
handheld will automatically begin connecting. Once connected, you can:

• Send and receive email messages by using Inbox. 
Before you can use Inbox, you need to provide the information it needs to 
communicate with the email server. 

For instructions, see "Connecting directly to an email server" on page 113. 

• Visit Web and WAP pages by using Pocket Internet Explorer. 
For more information, refer to "10 Using Microsoft® Pocket Internet 
Explorer" on page 115.

• Send and receive instant messages with MSN Messenger. 
For more information, refer to "MSN® Messenger" on page 55.

Ending a connection 
To disconnect, do any of the following:

• When connected via cable or cradle, detach your handheld from the cable or 
cradle.

• When connected via Infrared, move your handheld away from the computer. 
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• When connected via dial-up or VPN, tap the Connection icon  on your 
navigation bar, and then tap End. 

• When connected via a network (Ethernet) card, remove the card from your 
handheld. 

Connecting directly to an email server
You can set up a connection to an email server so that you can send and receive email 
messages by using a modem or network connection and Inbox on your handheld.

NOTE: The ISP or network must use a POP3 or IMAP4 email server and an SMTP gateway.

You can use multiple email services to receive your messages. For each email service 
you intend to use, first set up and name the email service. If you use the same service 
to connect to different mailboxes, set up and name each mailbox connection.

To set up an email service
1 In Inbox on your handheld, tap Services. 

2 Tap New Service. 

3 Follow the directions in the New Service wizard.

For an explanation of a screen, tap  and then Help. When finished connecting to 
your email server, tap Services and then Connect. 

For more information on using the Inbox program, see "Inbox" on page 43. 

Getting help on connecting
More information on the procedures described here, as well as information on 
additional procedures, can be found in the following locations:

• The section on "Inbox" on page 43. 

• Online Help of your handheld. Tap  and then Help. Tap View, All Installed 
Help, and then Inbox or Connections.

• ActiveSync Help on the your computer. In ActiveSync, click Microsoft 
ActiveSync Help on the Help menu.

• For troubleshooting information, see the Pocket PC Web site at 
(http://www.microsoft.com/mobile/pocketpc/). 

http://www.microsoft.com/mobile/pocketpc
http://www.microsoft.com/mobile/pocketpc
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10 Using Microsoft® 
Pocket Internet Explorer
Use Microsoft® Pocket Internet Explorer to view Web or WAP pages in either of these 
ways:

• During synchronisation with your computer, download your favorite links 
and mobile favorites that are stored in the Mobile Favorites subfolder of 
Internet Explorer on your computer.

• Connect to an Internet service provider (ISP) or network and browse the Web. 
To do this, you'll need to create the connection first, as described in "9 
Getting connected" on page 101.

When connected to an ISP or network, you can also download files and programs 
from the Internet or intranet.

Mobile Favorites folder
Only items stored in the Mobile Favorites subfolder in the Favorites folder of Internet 
Explorer on your computer will be synchronised with your handheld. This folder was 
created automatically when you installed ActiveSync. 

Favorite links
During synchronisation, the list of favorite links in the Mobile Favorites folder on your 
computer is synchronised with Pocket Internet Explorer on your handheld. Both 
locations are updated with changes made to either list each time you synchronise. 
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Unless you mark the favorite link as a mobile favorite, only the link will be 
downloaded to your handheld, and you will need to connect to your ISP or network to 
view the content. 

For more information on synchronisation, see ActiveSync Help on your computer.

Mobile favorites 
If you are using Microsoft Internet Explorer 5.0 or later on your computer, you can 
download mobile favorites to your handheld. Synchronising mobile favorites 
downloads Web content to your handheld enable you to view pages while you are 
disconnected from your ISP and computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites 
quickly.

To create a mobile favorite
1 In Internet Explorer on your computer, click Tools and then Create Mobile Favorite.

2 To change the link name, enter a new name in the Name box. 

3 Optionally, in Update, select a desired update schedule.

NOTE: If you did not specify an update schedule, you will need to manually download 
content to keep the information updated on both your computer and handheld. Before 
synchronising with your handheld, in Internet Explorer on your computer, click Tools and 
then Synchronise. You will see the last time content was downloaded to the computer, and 
you can manually download content if needed.

4 Click OK. 

Internet Explorer downloads the latest version of the page to your computer.

TIP: You can add a button to the Internet Explorer toolbar for creating mobile favorites. In 
Internet Explorer on your computer, click View, Toolbars, and then Customise.

To download a mobile favorite 
1 Right-click the mobile favorite and then click Properties. 

2 In the Download tab, specify the number of links deep you want to download. 

To conserve handheld memory, go only one level deep.

3 Synchronise your handheld and computer. 

Mobile favorites that are stored in the Mobile Favorites folder in Internet Explorer are 
downloaded to your handheld.

To save handheld memory in downloading mobile favorites
Mobile favorites take up storage memory on your handheld. To minimise the amount 
of memory used, observe the following:

• In the settings for the Favorites information type in ActiveSync options, turn 
off pictures and sounds, or stop some mobile favorites from being 
downloaded to your handheld. 
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• Limit the number of downloaded linked pages. 
a In Internet Explorer on the computer, right-click the mobile favorite you want 

to change and then click Properties. 

b In the Download tab, specify 0 or 1 for the number of linked pages you want 
to download.

AvantGo channels
AvantGo is a free interactive service that gives you access to personalised content and 
thousands of popular Web sites. You subscribe to AvantGo channels directly from your 
handheld, then, you synchronise your handheld and computer, or connect to the 
Internet to download the content. For more information, visit the AvantGo Web site.

Signing up for AvantGo
1 In ActiveSync options on your computer, turn on synchronisation for the AvantGo 

information type.

2 In Pocket Internet Explorer on your handheld, tap the Favorites button to display your 
list of favorites.

3 Tap the AvantGo Channels link.

4 Tap the Activate button.

5 Follow the onscreen directions. 

6 To complete the setup, synchronise your handheld with your computer and then tap 
the My Channels button.

When synchronisation is complete, tap the AvantGo Channels link in your list of 
favorites to see a few of the most popular channels. 



10 Using Microsoft® Pocket Internet Explorer
Using Pocket Internet Explorer

118   

To add or remove channels
• Tap the Add or Remove link.

Using Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and channels that 
have been downloaded to your handheld without connecting to the Internet. You can 
also connect to the Internet through an ISP or a network connection and browse the 
Web.

To view mobile favorites and channels
1 Tap the Favorites button to display your list of favorites.

Hide pictures button.
Favorites button.

Home button.

Refresh button.
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2 Tap the page you want to view. 

You'll see the page that was downloaded the last time you synchronised with your 
computer. If the page is not on your handheld, the favorite will be dimmed. You will 
need to synchronise with your computer again to download the page to your 
handheld, or connect to the Internet to view the page.

To browse the Internet
1 Set up a connection to your ISP or corporate network, as described in"9 Getting 

connected" on page 101.

2 To connect and start browsing, do one of the following:

• Tap the Favorites button, and then tap the favorite you want to view.
• Tap View and then Address Bar. In the address bar that appears at the top of 

the screen, enter the Web address you want to visit and then tap Go. Tap the 
arrow to choose from previously entered addresses.

• To add a favorite link while using the handheld: 
a Go to the page you want to add. 

b Tap and hold on the page.

c Tap Add to Favorites.

Tap to add or delete
a folder or favorite link.

Tap the favorite you
want to view.
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11 Customising your 
handheld
You can customise your handheld based on your personal requirements and 
preferences as well as depending on your usual work modes. Customise your 
handheld by doing either of the following: 

• Adjust the handheld settings
• Add or remove programs

Adjusting handheld settings
You can adjust the settings of your handheld to suit the way you work.

To access Settings

• Tap , then Settings. 
The Settings window has three tabs—Personal, System, and Connections, each of 
which has its own set of options. 

The succeeding sections show the configuration page of each the Settings options. For 
detailed instructions on these pages, access the page from your handheld, tap , 
then Help. 
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Personal

Buttons
Assign your favorite programs to any of the Quick buttons.
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Input
Select an input method, options for word completion and other related settings.

Menus
Customise what appears on the  menu, and enable a pop-up menu from the New 
button.



11 Customising your handheld
Adjusting handheld settings

124   

Owner Information
Enter personal information and customise text display when handheld is turned on. 

Password
Set a password to prevent unauthorized access to your handheld.
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Sounds & Notification
Select the types of action you want to hear sounds for and define how you want to be 
notified about different events.

Today
Customise the look and the information that is displayed on the Today screen.
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System

About
Displays your handheld’s version and copyright information; includes an option to 
define a device ID.
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Backlight
Define settings for backlight control. 

Clock
Change the time or set alarms. 
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Memory
Adjust allocation of storage and main memory.

Microphone 
Enable or disable the AGC (Automatic Gain Control) function—volume control when 
making an audio recording.  
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Power
Define settings to minimise power consumption. 
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Regional Settings
Set default number and time display formats and other related options.
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Remove Programs
Remove programs from storage memory.

Screen
Align screen and enable the ClearType feature.

WLAN 
Configure settings for your handheld’s WLAN utility. For more information, refer to 
page 104. 
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Connections

AvantGo Connect
Set server settings and related options for AvantGo. 
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Beam
Define settings for the beam function.

Connections
Adjust settings for connecting to the Internet or to a local network. 
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Network Adapters
Select your handheld’s network adapter and set its properties.

Adding and removing programs
Programs bundled with your handheld at the factory are stored in ROM (read-only 
memory). You cannot remove these programs, and you'll never accidentally lose ROM 
contents. ROM programs can be updated using special installation programs with a 
*.xip extension. All other programs and data files installed to your handheld after 
factory installation are stored in RAM (random access memory). 

You can install any program created for your handheld, as long as it has enough 
memory. The most popular place to find software for your handheld is on the Pocket 
PC Web site (http://www.microsoft.com/mobile/pocketpc/).

Adding programs
You can add programs to your handheld either by using ActiveSync or by 
downloading the program from the Internet. 

To add programs using ActiveSync
You'll need to install the appropriate software for your handheld on your computer 
before installing it on your handheld.

1 Determine your handheld and processor type so that you know which version of the 
software to install. 

a Tap  and then Settings. 

b On the System tab, tap About. 

c In the Version tab, make a note of the information in Processor. 

http://www.microsoft.com/mobile/pocketpc
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2 Download the program to your computer (or insert the CD or disk that contains the 
program into your computer). 

You may see a single *.xip,  *.exe, or *.zip file, a Setup.exe file, or several versions of 
files for different device types and processors. Be sure to select the program designed 
for a Pocket PC and your handheld’s processor type.

NOTE: Read any installation instructions, Read Me files, or documentation that come with 
the program. Many programs provide special installation instructions.

3 Connect your handheld to your computer.

4 Double-click the *.exe file.

• If the file is an installer, the installation wizard will begin. Follow the 
directions on the screen. Once the software has been installed on your 
computer, the installer will automatically transfer the software to your 
handheld. 

• If the file is not an installer, you will see an error message stating that the 
program is valid but it is designed for a different type of computer. You will 
need to move this file to your handheld. If you cannot find any installation 
instructions for the program in the Read Me file or documentation, use 
ActiveSync Explore to copy the program file to the Program Files folder on 
your handheld. For more information on copying files using ActiveSync, see 
ActiveSync Help. 

5 Once installation is complete, tap , Programs, and then the program icon to launch 
it.

To add a program directly from the Internet
1 Determine your handheld and processor type so that you know which version of the 

software to install. 

a Tap  and then Settings. 

b On the System tab, tap About. 

c In the Version tab, make a note of the information in Processor. 

2 Download the program to your handheld straight from the Internet using Pocket 
Internet Explorer. 

You may see a single *.xip,  *.exe or *.zip file, a Setup.exe file, or several versions of 
files for different device types and processors. Be sure to select the program designed 
for a Pocket PC and your handheld’s processor type.

NOTE: Read any installation instructions, Read Me files, or documentation that comes with 
the program. Many programs provide special installation instructions.

3 Tap the file, such as a *.xip or *.exe file. 

The installation wizard will begin. 

4 Follow the directions on the screen.
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Removing programs

1 Tap  and then Settings. 

2 On the System tab, tap Remove Programs.

3 Tap the program you wish to remove. 

4 Tap Remove. 

If the program does not appear in the list of installed programs, use File Explorer on 
your handheld to locate the program: 

1 Tap and hold the program. 

2 Tap Delete on the pop-up menu.

Adding a program to the Start menu
• Tap , Settings, Menus, the Start Menu tab, and then the check box for the 

program. 
If you do not see the program listed, you can either use File Explorer on your 
handheld to move the program to the Start Menu folder, or use ActiveSync 
on your computer to create a shortcut to the program and place the shortcut 
in the Start Menu folder.
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To add a Start menu program using File Explorer 
on your handheld

1 Tap , Programs, File Explorer, and locate the program (tap the folder list, labeled 
My Documents by default, and then My Device to see a list of all folders on your 
handheld). 

2 Tap and hold the program and tap Cut on the pop-up menu. 

3 Open the Start Menu folder located in the Windows folder, tap and hold a blank area 
of the window. 

4 Tap Paste on the pop-up menu. 

5 The program will now appear on the  menu. 

For more information on using File Explorer, see "To use File Explorer" on page 31.

To add a Start menu program using ActiveSync 
on your computer

1 Use the Explorer in ActiveSync to explore your handheld files and locate the program. 

2 Right-click the program, and then click Create Shortcut. 

3 Move the shortcut to the Start Menu folder in the Windows folder. 

4 The shortcut now appears on the   menu. 

For more information on using ActiveSync, see ActiveSync Help on your computer.



11 Customising your handheld
Adding a program to the Start menu

138   



 139
 

Index
A
Acer Versatile Connector 93
Acrobat Reader for Pocket PC 85
ActiveSync 99
add program 134
AvantGo channels 117

B
backlight 4
Backup

opening 65
Restore function 70

Backup/Restore 64
Block Recognizer 20

C
Calendar 33
command interface 14

command bar 17
hardware buttons 14
navigation bar 16
notifications 18
pop-up menus 17
Today screen 15

status icons 15
connectivity features 101

connect to email server 113
connect to Internet 110
connect to network 111
email service 113
end connection 112
help 113
infrared

receive 102
wireless communication

activating 103
configuring 103

Contacts 36
copyright ii
customise features 121

handheld settings 121
install/remove program

add 134
using ActiveSync 134
via Internet 135

remove 136
customise handheld 121

E
email

manage folders 47
synchronise 44

email server 113
email service 113
enter data 19

drawing on the screen 24
recording a message 26
using input panel 19

Block Recognizer 20
Letter Recognizer 20
soft keyboard 20
Transcriber 21

using My Text 27
writing on the screen 21

convert to text 22
expansion features 91

Acer Versatile Connector 93
expansion sleeve 93

attaching expansion sleeve 94
inserting CompactFlash card 95
inserting PC Card 96
removing CompactFlash card 96
removing PC Card 97

Memory Stick 91
inserting 91
removing 92

H
handheld

guides v
maintenance vi
optional accessories vi
package contents vi
resetting vii

handheld features 1
audio 1
battery pack 2

install 8
uninstall 9

connectivity 1
display 1
ergonomics 2
expansion 2
performance 1

handheld setup
charging 11

LED status 12
through the Acer Versatile Connector 12

connecting cradle 10
installing battery 12
installing Microsoft ActiveSync software 7

initial synchronisation 13



140   

I
IA Album LE 75

menus 76
Inbox 43
input panel 19
Internet 110

L
Letter Recognizer 20

M
manage applications

application list 29
finding information 31
opening 29
organising information 31
switching 29

Memory Stick 91
Microsoft Pocket Internet Explorer 115

AvantGo 117
signup 117

Mobile Favorites
create mobile favorite 116
favorite links 115

using 118
view mobile favorites 118

Microsoft Pocket Outlook 33
Calendar 33

create meeting request 36
open 33
schedule appointment 34

Contacts 36
create contact 37
find contact 38
open 36

Inbox 43
connect to email server 44
manage folders 47
Message list 45
open 43
synchronise email 44

Notes 42
create note 42
open 42

Tasks 39
open 39

Microsoft Pocket PC 2002 49
companion programs 49

Microsoft Reader
get book 59
read book 59
Reader features 60

remove book 61
use Guidebook 58
using Library 59

MSN Messenger 55, 57
chat with contacts 56
requirements 55
set up 56
work with contacts 56

Pocket Excel 53
File list 54
protect workbook 54

Pocket Word 49
enter data

drawing mode 52
recording mode 53
typing mode 50
writing mode 51

File list 50
Windows Media Player for Pocket PC 57

Microsoft Reader 58
Mobile Favorites folder 115
MSN Messenger 55
My Text 27

N
Notes 42

P
Pocket Excel 53

protect workbook 54
Pocket Word 49
PocketTV 86

R
RecentDo 63
remove program 136

S
system tour 3

bottom view 7
front view 3
left view 5
top view 6

T
Tasks 39
third-party applications 63

Acrobat Reader for Pocket PC 85
Backup/Restore 64
IA Album LE 75

key features 76
Capture button 76
Crop and Save 76



 141
 

menus 76
File 76
Tools 81

screen capture preferences 82
View 78

select view 79
PocketTV 86

Command bar 86
Fullscreen/Landscape switch 86

Menu 88
Options 89
Seek bar 87
Status bar 87

Transcriber 21

W
Windows Media Player for Pocket PC 57



142   


	About this Manual
	First things first
	Your guides
	Package contents
	Optional accessories
	Taking care of your Acer n20
	Proper care and usage of your Acer n20
	Resetting your Acer n20

	Locking your Acer n20

	Contents
	1 Getting started
	Features summary
	Performance
	Display
	Audio
	Connectivity
	Expansion
	Battery pack
	Design and ergonomics

	Acer n20 tour
	Front view
	Left view
	Top view
	Bottom view

	Preparing to use your Acer n20
	Installing the Microsoft® ActiveSync® software
	Installing the battery pack
	Connecting the cradle
	Charging your Acer n20
	Setting up your Acer n20
	Performing the first synchronisation process

	Command interface
	Hardware buttons and the stylus
	Today screen
	Navigation bar and command bar
	Pop-up menus
	Notifications


	2 Entering data in your Acer n20
	Using the input panel
	To type with the soft keyboard
	To use Letter Recognizer
	To use Block Recognizer
	To use Transcriber

	Writing on the screen
	To write on the screen

	Drawing on the screen
	To create a drawing

	Recording a message
	To create a recording
	To play a recording

	Using My Text
	To insert a My Text message


	3 Managing applications and information
	Opening an application
	Switching between applications
	Finding and organising information
	To use Find
	To use File Explorer


	4 Managing Microsoft® Pocket Outlook applications
	Calendar
	Scheduling an appointment
	Creating a meeting request

	Contacts
	Creating a contact
	Finding a contact

	Tasks
	Creating a task

	Notes
	Creating a note

	Inbox
	Synchronising email messages
	Connecting directly to an email server
	Using the Message list
	Composing a message
	Managing email messages and folders


	5 Managing Microsoft® Pocket PC 2002 companion programs
	Pocket Word
	Creating a new file
	Entering information

	Pocket Excel
	Creating a new workbook
	Displaying the toolbar
	Protecting your workbooks

	MSN® Messenger
	Setting up an account
	Working with contacts
	Chatting with contacts

	Microsoft® Windows Media™ Player for Pocket PC
	Microsoft® Reader for Pocket PC
	Using Guidebook
	Getting books on your Acer n20
	Using Library
	Opening a book
	Reading a book
	Using the Reader features
	Removing a book


	6 Using third-party applications
	RecentDo
	Backup/Restore
	Backup function
	Restore function
	Deleting a file from a storage card

	IA Album LE
	IA Album LE menus

	Acrobat Reader for Pocket PC
	PocketTV Enterprise Edition
	Command bar
	Seek/Progress bar
	Status bar
	Tools menu


	7 Using expansion features
	Memory Stick
	Inserting a Memory Stick
	Removing a Memory Stick

	Acer Versatile Connector
	Expansion sleeve
	Attaching your Acer n20 to the expansion sleeve
	Using the expansion sleeve


	8 Exchanging and updating data using ActiveSync®
	9 Getting connected
	Infrared communication
	Sending information
	Receiving information

	Wireless communication
	Activating the wireless feature
	Configuring the wireless settings
	Configuring the WLAN utility

	Connecting to the Internet
	To create a modem connection to an ISP
	To create an Ethernet connection to an ISP

	Connecting to a network
	To create a modem connection to a network
	To create an Ethernet connection to a network

	Starting a connection
	Ending a connection
	Connecting directly to an email server
	Getting help on connecting

	10 Using Microsoft® Pocket Internet Explorer
	Mobile Favorites folder
	Favorite links
	Mobile favorites

	AvantGo channels
	Signing up for AvantGo

	Using Pocket Internet Explorer
	To view mobile favorites and channels
	To browse the Internet


	11 Customising your handheld
	Adjusting handheld settings
	Personal
	System
	Connections

	Adding and removing programs
	Adding programs
	Removing programs

	Adding a program to the Start menu

	Index

